
Chapter 2

Working with Basic 
Tools 

After completing this chapter, you will be able to:
• Invoke tools
• Create keypoint curves
• Create text
• Understand the features of curves
• Create basic curves
• Create primitives
• Use different pick tools
• Use transform tools
• Shade objects

Learning Objectives
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 INTRODUCTION TO BASIC TOOLS
In the previous chapter, you have learned about the Alias interface and the location of various 
tools. In this chapter, you will learn about the basic tools that are used to create the entities 
like curves, line, arcs, primitives, and so on. You will also learn about the tools that are used 
to transform and pick the entities created. The transform tools are used to move, rotate, and 
scale objects. 

 INVOKING TOOLS
The tools for creating sketched entities and surfaces, transforming surfaces, and editing the 
entities are available in the Palette, Shelves window, and Control Panel. The tools in the 
Palette are placed under different tabs. Choose a tab; the respective tools will be displayed. 
Then, left-click on the required tool; the tool will be invoked and enclosed in a red box in the 
Palette. Figure 2-1 shows the Move tool being invoked after expanding the Transform tab 
in the Palette. You can also invoke a tool without expanding the tab. To do so, right-click on 
the tab; a shortcut menu with all tools associated with the tab will be displayed, as shown in 
Figure 2-2. Left-click on the required tool to invoke it.

 METHODS OF CREATING OBJECTS
In Alias, there are two methods to create an object. The fi rst method is to create an object 
(curves, surfaces, and so on) with default parameters or settings. The second method is to 
fi rst set the parameters of an object and then create it. In this chapter, the fi rst method is 
discussed for creating these objects. The effect of changing the parameters of these objects is 
also discussed in this textbook.

Figure 2-1  Invoking the Move tool 
after expanding the Transform tab 

Figure 2-2  Shortcut menu  
displayed on right-clicking on 
the Transform tab
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 CREATING KEYPOINT CURVES
The curves that retain attribute information such as radius,

Figure 2-3  The Keypoint Curve 
Toolbox 

 
sweep angle, and center point are known as keypoint 
curves. These curves retain constraints and relationships 
that can be used to edit them. To invoke any keypoint 
curve tool, choose the Keypoint Curve Toolbox tool 
from the Curves tab in the Palette; the Keypoint Curve 
Toolbox will be displayed, as shown in Figure 2-3. Next, 
invoke a tool from this window to create the 
corresponding keypoint curve. By default, guidelines 
are displayed when you create any keypoint curve. 
These guidelines help you align the curves with each 
other. You can turn off the display of these guidelines 
by choosing WindowDisplay > Toggles > Guidelines 
from the menu bar. Information retained by the keypoint curves can be viewed in the 
Information Window. You can modify the keypoint attributes by changing their values in this 
window. The different keypoint curves that can be created in Alias are discussed in next section.

 Creating a Line
  Palette: Curves > Keypoint Curve Toolbox > Line  

To draw a line, choose the Line 

Figure 2-4  Line drawn in the active window

tool from the Keypoint Curve 
Toolbox; you will be prompted to 

specify the start point of the line. Specify 
the position by entering coordinates in the 
promptline. You can also specify the start 
point of the line by clicking in the active 
window. After specifying the start point, 
you will be prompted to specify the            
endpoint of the line. Specify the endpoint 
of the line; the line will be created in the 
active window with the start point,                   
midpoint, endpoint, and the guidelines 
displayed on it, as shown in Figure 2-4. 
Note that the moment you click to specify 
the endpoint of the line, its linear                           
dimension will be displayed, as shown in Figure 2-5. But, after specifying the endpoint, the 
dimension will disappear. You can draw horizontal or vertical line using the steps given next.

1. If you specify the endpoint of the line by using the middle mouse button; a horizontal 
keypoint line will be created, as shown in Figure 2-6.

2. If you specify the endpoint of the line by using the right mouse button; a vertical keypoint 
line will be created, refer to Figure 2-6.
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To set the parameters of the Line tool, double-click on the Line tool; the Line (2 Point) 
Options dialog box will be displayed, as shown in Figure 2-7. The options in this dialog box 
are discussed next.

Figure 2-6  Vertical and horizontal keypoint lines 
created

Figure 2-5  Linear dimension displayed on the 
line  

Tip: To specify the length of the line dynamically, click and drag the cursor while 
specifying the endpoint of the line.

Degree
This edit box is used to specify the degree of the line.    

Figure 2-7  The Line (2 Point) Options 
dialog box

 
The range of the degree is 1 to 7. By default, 1 is 
displayed in this edit box. You can also change the 
degree of the line by using the slider bar given on the 
right of this edit box.

Reset
This button is used to revert to the default settings or 
parameters of the Line tool. 

Save
This button is used to save the current parameter values in the Line (2 Point) Options 
dialog box. The next time when you invoke this dialog box for creating another line, the 
saved parameter values will be displayed in the dialog box again. 

Exit
This button is used to exit the Line (2 Point) Options dialog box. 

Go
Choose this button to draw the line with the modifi ed parameter values. In this case, the values 
set will not be saved for the next line to be drawn.
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After specifying all parameters of the line, choose the Go button to draw the line. Specify 
the start and the endpoint; the line with the specifi ed settings will be created in the window.

To exit the Line tool, choose the Pick object button from the Pick tab in the Palette. The tools 
in the Pick tab of the Palette will be discussed in detail later in this chapter.

 Creating Polylines
 Palette: Curves > Keypoint Curve Toolbox > Line > Polyline  

You can draw continuous lines by using the Polyline tool. While creating a polyline,  
the endpoint of the previous line becomes the start point of the next line and you 
need to specify only the endpoints of the successive lines. To create a polyline, press 

and hold the left mouse button on the Line tool from the Keypoint Curve Toolbox; a fl yout 
will be displayed. Choose the Polyline tool from this fl yout; the button will get enclosed 
within a red box, indicating that the tool is active. Also, you will be prompted to specify the 
start point of the line. Click in the active window or enter the coordinates in the promptline 
to specify the start point of the line and press ENTER. Next, you will be prompted to specify 
the endpoint of the line. Specify the endpoint of the fi rst line segment of the polyline and 
continue specifying the endpoints of the successive line segments until you have created the 
polyline of required segments. Next, choose the Pick object tool from the Pick tab in the 
Palette to exit the Polyline tool. Figure 2-8 shows a three-segment polyline created by using 
the Polyline tool.

To set the parameters of the Polyline tool, double-click on the Polyline tool; the Line Poly 
Options dialog box will be displayed, as shown in Figure 2-9. The options in this dialog box 
are the same as those discussed in the Line tool.

Figure 2-8  A three-segment polyline Figure 2-9  The Line Poly Options dialog box

 

Creating a Parallel Line
  Palette: Curves > Keypoint Curve Toolbox > Line > Parallel line 

You can create a line parallel to an existing line or curve by using the Parallel line 
tool. Invoke the Parallel line tool from the Line fl yout in a way similar to the Polyline 
tool. On doing so, you will be prompted to select a curve to which you need to draw 

the parallel line. Select the curve or the line from the active window; you will be prompted to 
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specify the start point of the line. Click in the active window or enter the coordinates in the 
promptline to specify the start point of the line. Next, you will be prompted to specify the 
endpoint of the line. Specify the endpoint; a line parallel to an existing line will be created, 
as shown in Figure 2-10. If you select a circle or an arc, a tangent line will be displayed and 
the line drawn will be parallel to this tangent line, as shown in Figure 2-11.

Figure 2-11  Line parallel to the tangent line of a 
three point arc

Figure 2-10  Line parallel to the existing line

To set the parameters of the Parallel line tool, double-click on the Parallel line tool; the Line 
Parallel Options dialog box will be displayed. The options in this dialog box are the same as 
those discussed in the Line tool.

Note
When you click to specify the fi rst point of the parallel line, the linear distance between the two 
lines is displayed momentarily between the two lines. Similarly, when you click to specify the 
endpoint of the parallel line, the linear dimension of the line is displayed momentarily on the line.

 Creating a Line at Angle
  Palette: Curves > Keypoint Curve Toolbox > Line > Line at angle 

You can create a line at an angle to an existing line or a curve by using the Line at 
angle tool. Invoke the Line at angle tool from the Line fl yout in a way similar to the 
Polyline tool; you will be prompted to select a curve to make the line inclined to. 

Select a curve or a line from the active window; you will be prompted to specify the endpoint 
of the line or the relative angle. Click in the active window or enter the angle in the promptline. 
If you click in the active window, a new line at an arbitrary angle value to the existing curve 
or line will be created, as shown in Figure 2-12. If you enter an angle in the promptline and 
then click in the active window to specify the endpoint; a new line at the specifi ed angle in 
the clockwise direction to the existing curve will be created. In case of a curve, the new line 
will be created at an angle to the line that passes through the start point of the line and the 
endpoint of the curve, as shown in Figure 2-13. While specifying the endpoint of the line, 
drag the endpoint to display the angular dimension of the line. Note that this angular 
dimension will disappear after you specify the endpoint of the line. 
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To set the parameters of the Line at angle tool, double-click on the Line at angle tool; the 
Line Angle Options dialog box will be displayed. The options in this dialog box are the same 
as those discussed in the Line tool.

 

Figure 2-13  A line created at an arbitrary 
angle to the existing curve 

Figure 2-12  A new line created at an arbitrary 
angle to the existing line 

Tip: You can use the Snap to CV/Edit Point and Snap to Curve buttons on the  
right of the promptline to draw the lines (parallel, perpendicular, tangent, and so 
on) from/at a specifi c curve or a CV/edit point. 

Creating a Circular Arc
  Palette: Curves > Keypoint Curve Toolbox > Circular arc 

You can create a circular arc or circle by specifying its center point and a point on its 
circumference. You can do so by using the Circular arc tool. To draw a circular arc 
using this tool, choose the Circular arc tool from the Keypoint Curve Toolbox; you 

will be prompted to specify the center point of the circle. Click in the active window to specify 
the center point of the circle; you will be prompted to specify a point on the radius of the 
circle. Click in the active window at the required distance from the center point; a circle will 
be created, as shown in Figure 2-14. While specifying the location on the radius of the circle, 
the dimension is displayed momentarily in green on the screen. Note that the dimension 
varies as you drag the mouse and disappears after you specify the endpoint of the circle.

To set the parameters of the Circular arc tool, double-click on the Circular arc tool; the Circle 
Options dialog box will be displayed, as shown in Figure 2-15.

The options in this dialog box are discussed next.

Degree
This edit box is used to specify the degree of the circular arc. The range of the degree is 2 
to 7. By default, 6 is displayed in this edit box. You can also change the degree of the arc by 
using the slider bar given on the right of this edit box.
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Spans
This edit box is used to specify the number of spans of the circular arc. The range of spans 
is 1 to 14. By default, 1 is displayed in this edit box. You can also change the spans of the arc 
by using the slider bar given on the right of this edit box

Figure 2-14  Circle created using the Circular 
arc tool

Figure 2-15  The Circle Options dialog box

 

 Creating an Ellipse
  Palette: Curves > Keypoint Curve Toolbox > Ellipse  

To create an ellipse, choose the Ellipse tool from the Keypoint Curve Toolbox; you 
will be prompted to specify the center of the ellipse. Click in the active window; you 
will be prompted to specify the endpoint for the ellipse major axis. Click in the active 

window; the ellipse will be created. Note that the major and minor radii of the ellipse will be 
displayed when you specify the endpoint for the ellipse. Also, the dimensions of both the axes 
keep changing as you drag the mouse.

To set the parameters of the Ellipse tool, double-click on the Ellipse tool; the New Ellipse 
Options dialog box will be displayed, as shown in Figure 2-16.

The options in the New Ellipse Options dialog box

Figure 2-16  The New Ellipse Options 
dialog box

 
are discussed next.

 Ellipse defi nition 
The Ellipse defi nition area is used to specify 
the option for creating an ellipse. The two 
radio buttons in this area are discussed below:

 Axis endpoints
Select this radio button to create an ellipse 
by specifying the endpoints of the major 
axis. On selecting this radio button, you will 
be prompted to specify the start point of the 
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major axis. You can specify the start point by entering the coordinates in the promptline 
or by clicking at the required location in the active window. After specifying the start 
point, you will be prompted to specify the endpoint of the major axis. The ellipse created 
using the Axis endpoints radio button is shown in Figure 2-17. To specify the endpoint, 
click on the screen; the dimensions will be displayed momentarily in green color. These 
dimensions will disappear after you specify the endpoint.

 Centre and end point
The Centre and end point radio button is selected by default and is used to create an ellipse 
by specifying the center and the endpoint of the major axis. With this radio button selected, 
you need to specify the center point of the ellipse. Specify the center by entering the 
coordinates in the promptline or click at the required location in the active window. Next, 
you will be prompted to specify the endpoint of the major axis of the ellipse. The ellipse 
created by selecting the Centre and end point radio button is shown in Figure 2-18.
 

Figure 2-18  Ellipse created on selecting the 
Centre and end point radio button

Figure 2-17  Ellipse created on selecting the 
Axis endpoints radio button

 Axis length ratio
Axis length ratio is the ratio of the length of the minor axis to that of the major axis. You can 
specify this ratio by entering a value in the Axis length ratio edit box. You can also specify 
the value using the slider bar given on the right of this edit box. Figure 2-19 shows ellipses 
created with axis length ratios of 0.3 and 0.8.

 Sweep
You can enter the value of the sweep angle of the ellipse in the Sweep edit box. By default, 
its value is 360 degrees. If you need to create an open ellipse, enter a value between 0 degree 
to 360 degrees. Figure 2-20 shows ellipses created with sweep angles 180 and 270 degrees.
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Figure 2-20  Ellipses created with different sweep 
angles

Figure 2-19  Ellipses created with different axis 
length ratios

 Creating a Rectangle
  Palette: Curves > Keypoint Curve Toolbox > Rectangle  

In Alias, you can create a rectangle by specifying the starting and ending positions of 
the rectangle. To do so, you can use the Rectangle tool. The starting and ending 
positions of the rectangle are its two diagonally opposite corners. To create a rectangle, 

choose the Rectangle tool from the Keypoint Curve Toolbox; you will be prompted to specify 
the starting position of the rectangle. You can specify the starting position by entering the 
coordinates in the promptline or by clicking at the required location in the active window. On 
specifying the starting position, you will be prompted to specify the ending position of the 
rectangle. Specify the ending position; the rectangle will be created, as shown in Figure 2-21.

Tip: You can get the information such as transformation, pivot, bounding box, and 
curve geometry about any curve, whether a line or an arc, from the Information 
Window dialog box. To invoke this dialog box, fi rst select the curve from the active 
window and then choose Windows > Information > Information Window from 
the menu bar. Alternatively, you can press CTRL+5 keys to display the Information 
Window dialog box.

 Creating a Three Point Arc
  Palette: Curves > Keypoint Curve Toolbox > Arc (three point)  

You can create an arc by specifying three points. You can do so by using the Arc (three 
point) tool. To create a three point arc, choose the Arc (three point) tool from the       
Keypoint Curve Toolbox; you will be prompted to specify the fi rst point. Click in the 

active window or enter the coordinates in the promptline to specify the fi rst point. Next, specify 
the second and third points of the arc; the three point arc will be created, as shown in 
Figure 2-22. You can specify the second and third point of the arc in three different ways by 
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using the three mouse buttons. Click in the 

Figure 2-21  Rectangle created in the orthographic 
window

active window with the middle mouse 
button; the point will  be placed 
horizontally with respect to the previous 
point. If you specify the point with the 
right mouse button, the point will be 
placed vertically with respect to the 
previous point. If you specify the point 
with the left mouse button, the point will 
be placed freely. If you drag the mouse 
to specify the third point of the arc, the 
center point of the arc as well as its radius 
will change dynamically, as shown in 
Figure 2-23.

To set the parameters of the Arc (three point) tool, double-click on the Arc (three point) tool; 
the Arc (3 Point) Options dialog box will be displayed, as shown in Figure 2-24. 

Figure 2-23  Radius displayed on the arc while 
dragging the endpoint

Figure 2-22  A three point arc

The options in this dialog box are discussed next.

Degree
This edit box is used to specify the degree of the three

Figure 2-24  The Arc (3 Point) Options 
dialog box

 
point arc. The range of the degree is from 2 to 7. 
You can also change the degree of the arc by using 
the slider bar given on the right of this edit box.

 Spans
This edit box is used to specify the spans of the 
three point arc. The range of the spans is from 1 
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to 14. By default, 1 is displayed in this edit box. You can also change the spans of the arc by 
using the slider bar given on the right of this edit box.

 Creating a Two Point Arc
  Palette: Curves > Keypoint Curve Toolbox > Arc (three point) Arc (two point)  

You can create an arc by specifying the two endpoints and the center point in succession. You 
can do so by using the Arc (two point) tool.

Figure 2-25  Two point arc displaying the radius 
of the curve

 
To create a two point arc, press and hold 
the left mouse button on the Arc (three 
point) tool in the Keypoint Curve     
Toolbox; a fl yout will be displayed. Choose 
the Arc (two point) tool from this fl yout; 
you will be prompted to specify the start 
point of the arc. Click in the active window 
or enter the coordinates in the promptline 
to specify the start point; you will be        
prompted to specify the endpoint of the 
arc. Specify the endpoint; you will be 
prompted to specify the center or the        
radius of the arc. Click in the active window 
to specify the center/radius of the arc; the 
two point arc will be created. When you 
click to specify the center/radius of the arc, the radius of the arc will be displayed                                   
momentarily in the active  window, as shown in Figure 2-25. You can also enter radius of the 
arc in the promptline. On specifying the center/radius, you will notice that two possible curves 
that can be created are displayed. Click on the side where you need the arc. While specifying 
the endpoint of the arc, the three mouse buttons function in a way similar to the Arc (three 
point) tool.                                                                               

To set the parameters of the Arc (two point) tool, double-click on the Arc (two point) tool; 
the Arc (2 Point) Options dialog box will be displayed. The options in this dialog box are the 
same as those discussed in the Arc (three point) tool.

Tip: While specifying the endpoint of an arc, the mouse buttons function in the 
same way as in the Arc (three point) tool.

 Creating an Arc Tangent to a Curve
  Palette: Curves > Keypoint curve toolbox > Arc (three point) > 
  Arc tangent to curve     

The Arc tangent to curve tool is used to create an arc that is tangent to an existing 
curve or a line. To create an arc tangent to a curve, choose the Arc tangent to curve 
tool from the Keypoint Curve Toolbox; you will be prompted to select the location 
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on the curve from which the arc tangent to the curve will start. Select the existing curve or 
line at any point to start the tangent arc, you will be prompted to specify the endpoint of the 
tangent arc. Click in the active window or enter coordinates in the promptline to specify the 
endpoint; the arc tangent to the line will be created, as shown in Figure 2-26. 

To set the parameters of the Arc tangent to curve tool, double-click on the Arc tangent to 
curve tool; the Arc Tangent To Curve Options dialog box will be displayed. The options in 
this dialog box are the same as those discussed in the Arc (three point) tool.

 Creating a Concentric Arc
  Palette: Curves > Keypoint Curve Toolbox > Arc (three point) > Concentric arc  

You can create an arc that is concentric to an existing arc by using the Concentric arc 
tool. To create such an arc, choose the Concentric arc tool from the Keypoint Curve 
Toolbox; you will be prompted to select the arc to which the arc will be concentric. 

Select an existing arc; you will be prompted to specify the start point of the arc. Click in the 
active window or enter coordinates in the promptline to specify the start point. Next, you will 
be prompted to specify the endpoint of the arc. Specify the endpoint of the arc; the concentric 
arc will be created, as shown in Figure 2-27.

To set the parameters of the Concentric arc tool, double-click on the Concentric arc tool; 
the Concentric Arc Options dialog box will be displayed. The options in this dialog box are 
the same as those discussed in the Arc (three point) tool.

Figure 2-27  Concentric arcFigure 2-26  Arc tangent to the line

 Creating a Line Tangent to a Curve
  Palette: Curves > Keypoint Curve Toolbox > Line tangent to curve  

You can create a line tangent to an existing curve by using the Line tangent to curve 
tool. To draw a line tangent to a curve using this tool, choose the Line tangent to 
curve tool from the Keypoint Curve Toolbox; you will be prompted to specify the 

start point of the line. Click in the active window or enter the coordinates in the promptline 
to specify the start point of the line. Next, you will be prompted to select the curve to which 
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the line will be tangent. Select the existing curve from the active window; the line tangent to 
a curve will be created, as shown in Figure 2-28. If this line does not fi nd any tangent, a prompt 
will be displayed showing the error message as well as the instruction to select the curve to 
which the line will be tangent. If there are more than one tangent, the line will be created to 
the nearest tangent.

 Creating a Line Tangent from/to Curves
  Palette: Curves > Keypoint Curve Toolbox > Line tangent to curve > 
  Line tangent from/to curves       

You can create a line that is tangent to the two existing curves by using the Line tangent 
from/to curves tool. To invoke the Line tangent from/to curves tool, press and hold 
the left mouse button on the Line tangent to curve tool from the Keypoint Curve 

Toolbox; a fl yout will be displayed. Choose the Line tangent from/to curves tool from this 
fl yout; you will be prompted to select the curve from which the tangent line should start. 
Select one of the existing curves in the active window; you will be prompted to select the curve 
at which the tangent line should end. Select the second existing curve from the active window; 
a line tangent to the two selected curves will be created, as shown in Figure 2-29. If this line 
does not fi nd any tangent, a prompt will be displayed showing the error message as well as 
the instruction to select the curve to which the line will be tangent. If there are more than one 
tangent, the line will be created at the nearest tangent.

Tip: If there are two circles or circular arcs, then two possible tangent lines can 
be created. In such a case, you can click at the quadrant where you need to create 
a tangent line.

Figure 2-29  Line tangent to two curvesFigure 2-28  Line tangent to curve

 Creating a Line Perpendicular to a Curve
  Palette: Curves > Keypoint Curve Toolbox > Line tangent to curve >  
  Line perpendicular      

You can create a line perpendicular to an existing curve by using the Line perpendicular 
tool. The line is drawn perpendicular in such a way that it is normal to the apparent 
tangent of the curve. Choose the Line perpendicular tool from the Keypoint Curve 

Toolbox; you will be prompted to select the curve or the surface to which the line will be 
perpendicular. Also, six buttons namely, True, Projected, From Curve, To Curve, Next, and 
Change Settings will be displayed at the bottom of the active window. Select the curve or the 
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surface; you will be prompted to defi ne the endpoint of the perpendicular line. Click at the 
required position on the active window; a line perpendicular to the curve will be created, as 
shown in Figure 2-30. Next, you will be prompted to change the length of the perpendicular 
line either by modifying the position of the points or by entering the length in the promptline. 
Modify the length by dragging the line or entering the value at the promptline. To create a 
new perpendicular line, choose the Next button from bottom of the active window. 

You can create a line perpendicular to or from a curve with true or projected length. By default, 
the line created will be perpendicular to the curve in 3D space (as viewed from Perspective 
window). To change the default settings, choose the Change Settings button; all buttons will 
get activated and you can specify the new settings by choosing the required buttons. If you 
choose the Projected button from the active window, the line created will be perpendicular to 
the selected curve in the active orthographic window. With the From Curve button chosen, the 
start point of the perpendicular line will lie on the curve. If you choose the To Curve button, 
the endpoint of the perpendicular line will lie on the curve. 

To set the parameters of the Line perpendicular tool, double-click on the Line perpendicular 
tool; the Line Perpendicular Options dialog box will be displayed, as shown in Figure 2-31. 

The options in this dialog box are discussed next. 

Degree
This edit box is used to specify the degree of the perpendicular line. The range of the degree 
is from 1 to 7. You can also change the degree of the arc by using the slider bar given on the 
right of this edit box.

Type
This area can be used to specify the type of perpendicular line that will be created. The radio 
buttons in this area are discussed next.

True
This radio button is selected by default and creates a line perpendicular to the selected 
curve in 3D space (as viewed from Perspective window). When you specify the endpoint 
of the perpendicular line, the letter T will be displayed along with the length of the line 
momentarily.

Figure 2-30  Line perpendicular to a curve Figure 2-31  The Line Perpendicular 
Options dialog box
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Projected
Select this radio button to create a line perpendicular to the selected curve in the active 
orthographic window.

Note
The true and projected length of the perpendicular lines can be distinguished by checking the 
prefi xes that will be displayed along with the length when you specify its endpoint.

Select
This area can be used to specify whether the line will start from the curve or end at the curve. 
The radio buttons in this area are discussed next.

From Curve
This radio button is selected by default and creates the line perpendicular to the curve 
such that its start point lies on the curve. In this case, you need to specify the endpoint at 
any location in the active window.

To Curve
Select this radio button to create the perpendicular line such that the endpoint of the 
perpendicular line will lie on the curve. In this case, you need to specify the start point at 
any location in the active window.
 

 Creating Linearcs
 Palette: Curves > Keypoint Curve Toolbox > Line-arc 

In Alias, you can create a set of alternate 

Figure 2-32  Linearc

lines and arcs tangent to it. To create a set of 
alternate lines and tangent arcs, choose the 

Line-arc tool from the Keypoint Curve Toolbox; 
you will be prompted to specify the start point of the 
linearc. Click in the active window or enter the 
coordinates in the promptline; you will be prompted 
to specify the endpoint of the line. Specify the 
endpoint of the line; you will be prompted to specify 
the endpoint of the arc. Click in the active window 
or enter coordinates in the promptline. Repeat the 
process to    create a linearc, as shown in Figure 2-32. 
Note that the endpoint of the line becomes the start 
point of the arc. 

You can specify the endpoint of the linearc in three different ways by using the three mouse 
buttons. Click in the active window with the middle mouse button to specify the endpoint of 
the line; the endpoint will be placed horizontally with respect to the previous point. If you 
specify the endpoint with the right mouse button, the endpoint will be placed vertically with 
respect to the previous point. If you specify the endpoint with the left mouse button, the 
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endpoint will be placed freely. Specify the endpoint of the arc in a way similar to the endpoint 
of the line. While specifying the endpoint of the line or the arc, drag the endpoint to display 
the  dimension of the corresponding curve. Also, dragging the endpoint of the line or the arc 
changes the dimension of the corresponding curve.

Note
The arc segment always projects forward from the previous line. This type of arc is known as the 
convex arc. The concave arc is an arc that projects backward. To create a concave arc, you need 
to edit the convex curve, about which you will learn in the later chapters. Also, if you want to 
create the same type of segment as the previous one, double-click when specifying the endpoint 
of the segment.

 Creating Text
  Palette: Curves > Text 

You can create text in the active

Figure 2-33  Text created in the active window

window by using the Text tool. To 
do so, choose the Text tool from 

the Curves tab in the Palette. Next, click 
in the active window to specify the start 
point of the text string; an arrowhead 
defi ning the start point will be displayed 
in the   active window. Also, you will be 
prompted to enter the text string. Enter 
the text in the promptline; the text will be 
created. This text acts as a single object, but it consists of a string of characters. You can 
separate characters from the text string into individual objects by ungrouping the text. You 
can also create multiple strings of text in the active window. To exit the Text tool, choose the 
Pick object tool from the Pick tab in the Palette. You can create surfaces from the text by 
using the Set planar tool, which  will be discussed in Chapter 3. Figure 2-33 shows the text 
created in the active window.

Tip: To ungroup the characters of a string, select the string and then choose Edit > 
Ungroup from the menu bar; the characters of the string will behave as individual 
objects. An individual character may consist of more than one curve. You can 
ungroup the characters in a way similar to the text string.

To set the parameters of the Text tool, double-click on the Text tool; the Text Options dialog 
box will be displayed, as shown in Figure 2-34.

The options in the Text Options dialog box are discussed next.

Font
The Font area can be used to specify the font that is used to create text. By default, the Arial 
font is displayed in the Font Name display box. You can change font by choosing the required 
font from the font list given below the Font Name display box. Scroll down the font list to view 
all fonts. Note that the new settings will be applicable only to new entries.
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 Other Attributes                                       

Figure 2-34  The Text Options 
dialog box

  
This area is used to specify the attributes such as the 
style and size of the text. The options in this area are 
discussed next.

Style
Press and hold the left mouse button on the Regular 
button located on the right of the Style area to 
display a fl yout with four styles: Bold, Bold Italic, 
Italic, and Regular. The font styles will change with 
respect to the font selected in the font list. 

 Point Size
The Point Size edit box is used to specify the 
size of the text. By default, 24 is displayed                                                                                                    
in this edit box. You can change the text size by 
entering the new value in this edit box. You can also 
change the text size by using the slider bar given 
on the right of this edit box.   

 FEATURES OF A CURVE
Alias Design provides you with various tools to create a curve. Before creating curves, you 
need to know about the features that are associated with the curves. The features of a curve 
play an important role in its editing, modifi cation, transformation, inspection, and so on. The 
features of a curve are discussed next.

 Control Vertices
Control vertices (CVs) are the points in 3D 

Figure 2-35  Curve with different CV symbols

space that defi ne and control the creation 
of curves. You can edit curves by changing 
the position of their control vertices (CVs). 
The CVs of a curve at different points are 
indicated by different symbols. The fi rst 
CV is indicated by a ‘box’ symbol; the 
second CV by ‘u’ symbol; and the other 
CVs by ‘x’ symbol, as shown in Figure 2-35.

 Edit Points
The edit points allow you to create and edit curves. These edit points also determine the 
number of spans in a curve. The span is the length of the curve segment between two edit 
points. You can increase or decrease the number of edit points in a curve. Figure 2-36 shows 
the edit point of a curve.

Hulls
The lines joining the CVs of a curve are called hulls. The necessity of hulls arises when you 
increase the number of edit points and spans. Figure 2-37 shows the hull of a curve.
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Note
1. You can change the symbol of the CVs and the edit points of a curve by choosing the box icon 
given on the right of the Draw Style option. The Draw Style option can be invoked by choosing 
ObjectDisplay > Draw Style from the menu bar.
 
2. While editing the curves with the edit points, the editing tool starts searching the new curve 
through which the edit points will pass. The calculations that are done to fi nd the curve consume 
a lot of time. So, editing the curves with the edit points should be restricted to simple curves only. 

CREATING CURVES
In Alias Design, you can create different types of curves using the tools in the Curves tab of 
the Palette. The methods of creating the curves are discussed next. 

Figure 2-37  Hull of a curveFigure 2-36  Edit point of a curve

  Creating a Circle
  Palette:        Curves > Circle  

To create a circle, choose the Circle tool from the Curves tab in the Palette; you will 
be prompted to specify the new circle position. Click in the active window; a circle will 
be created.

Figure 2-38  The Circle Options dialog 
box

To set the parameters of the Circle tool, double-click 
on the Circle tool; the Circle Options dialog box 
will be displayed, as shown in Figure 2-38. 

The options in the Circle Options dialog box are 
discussed next.

 Periodic Circle
This check box is selected by default and is used to 
create a circle with closed curves. The closed curves 
are periodic or cyclic in nature. In other words, the 
fi rst and the last CVs of the circle overlap. If you 
clear this check box, a circle with open curves will be 
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created. In this case, the fi rst and the last CVs of this circle will only touch each other. There 
will be no overlapping of the spans.

 Degree
The Degree edit box is used to specify the degree of the NURBS circle. By default, the 5 is 
displayed in the edit box.  

 Sweep Angle
This edit box will be available only when you clear the Periodic Circle check box. The sweep 
angle defi nes the degree of rotation of the circle around its center. Enter the sweep angle of 
the circle in the Sweep Angle edit box.

Spans
This edit box is used to specify the number of spans of the open curve circle. The range of arc 
degree is from 1 to 14. You can also change the arc degree by using the slider bar given on the 
right of the Spans edit box. Figure 2-39 shows a circle drawn with the values 4 and 7 entered 
in the Degree and Spans edit boxes, respectively. Figure 2-40 shows a circle drawn with the 
values of 250, 5, and 7 entered in the Sweep Angle, Degree, and Spans edit boxes, respectively.

Note
When you click in the active window to specify the position of the circle, a manipulator will be 
displayed at the center of the circle. The manipulator will be discussed in the later chapters. 

Figure 2-40  Circle drawn with the values 250, 
5, and 7 entered in the Sweep Angle, Degree, 
and Spans edit boxes, respectively 

Figure 2-39  Circle drawn with the values 4 
and 7 entered in the Degree and Spans edit 
boxes, respectively   

Creating a CV Curve
  Palette: Curves > New Curves > New CV curve  

A curve created by defi ning specifi c points that do not lie on the curve is known as 
CV curve. The specifi c points on a CV curve act as control vertices for the curve. To 
create a CV curve, choose the New CV curve tool from the New Curves fl yout of the 

Curves tab in the Palette; you will be prompted to enter the new position of the CV. Click at 
the required location in the active window or enter the coordinates in the promptline to 
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specify the position of the fi rst CV; the CV 

Figure 2-41  Curve created using the New CV 
curve tool

will be placed in the active window. Next, 
you will be prompted again to specify the 
new position of the CV. Click in the active 
window or enter coordinates in the 
promptline to specify the new position. 
Similarly, specify other points to create the 
curve, as shown in Figure 2-41.

To set the parameters of the New CV 
curve tool, double-click on the New CV 
curve tool; the New CV Curve Options 
dialog box will be displayed, as shown in 
Figure 2-42.

The options in the New CV Curve Options dialog box are discussed next.

Figure 2-42  The New CV Curve Options dialog box

 Knot Spacing
The Knot Spacing area is used to specify the parameters for the edit points. The two radio 
buttons in the Knot Spacing area are discussed next.

 Chord
Select this radio button to create the curve such that the edit points are parameterized 
by the chord length, that is, the cumulative distance between the two edit points. The 
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starting point parameter value will be 0 and the endpoint parameter value of the curve 
will be equal to the chord length of the curve.

 Uniform 
This radio button is selected by default. With this option, the edit points of the curve will 
have the parameter value in the integer system. The fi rst edit point parameter value will 
be 0 and the next edit point parameter value will be equal to 1 and so on. 

 Curve Degree
The Curve Degree area is used to specify the degree of the curve. The curve created will satisfy 
the linear, quadratic, cubic, and other equations depending on the radio button selected. 
There are fi ve radio buttons in this area, 1, 2, 3, 5, and 7. The curve of degree of 1, 2, or 3 will 
create linear, quadratic, or cubic curves, respectively. By default, the 3 radio button is selected.

 Progressive Degree 
If the degree of a curve is ‘n’, you need to specify ‘n+1’ CVs to display the curve. If you select 
the Progressive Degree check box, the curve will be displayed after specifying the second CV 
irrespective of the degree of the curve. With this check box selected, you can view the degree 
and span changing in the Control Panel. However, the degree of the curve will increase up 
to the curve degree specifi ed in the New CV Curve Options dialog box.

Pivot Position
This area is used to specify the position of the pivot points (rotation and scaling pivots) on 
the drawn curve. The radio buttons in this area are discussed next.

Origin
This radio button is selected to position the pivot points at the origin (0,0,0).

Curve center
This radio button is selected  to position the pivot points at the center of the curve being drawn. 

First CV
This radio button is selected by default. As a result, the pivot points will be positioned at 
the fi rst CV.

Bounding box center
This radio button is selected to position the pivot points at the center of the bounding 
box of the curve being drawn. 

Last CV
This radio button is selected  to position the pivot points at the last CV of the curve being 
drawn.  
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 Create Guidelines
This check box allows you to create two guidelines perpendicular to each other every time 
you place a CV. Make sure the display of guidelines is turned on. You can do so by choosing 
WindowDisplay > Toggles > Guidelines from the menu bar.

Note
You can change the number of guidelines displayed by using the General Preferences dialog 
box that has been discussed in Chapter 1.

 Creating an Edit Point Curve
  Palette: Curves > New Curves > New CV curve > New Edit Point curve  

A curve created by defi ning specifi c points, which lie on the curve, is known as an edit 
point curve. These specifi c points on an edit point curve are known as edit points. To 
create an edit point curve, hold the left mouse button on the New CV curve tool from 

the New  Curve fl yout  of  the Curves tab in the Palette; a fl yout will be displayed. Next, 
choose the New Edit Point curve tool from the fl yout; you will be prompted to enter the 
position of the edit point. Click anywhere in the active window or enter coordinates in the 
promptline to specify the position of the fi rst edit point; the edit point will be placed in the 
active window. You will be prompted again

Figure 2-43  Curve created using the New Edit 
Point curve tool 

 
to specify the new edit point position. Click 
in the active window or enter coordinates 
in the promptline to specify the new edit 
point position. When you create a curve 
using the New Edit Point Curve tool, you 
can defi ne spans and view the curve after 
specifying the second point. The curve 
created using the New Edit Point curve 
tool is shown in Figure 2-43.

To set the parameters of the New Edit 
Point curve tool, double-click on the 
New Edit Point curve tool; the New Edit 
Point curve Options dialog box will be 
displayed. The options in this dialog box are the same as explained earlier in the New CV 
Curve Options dialog box. 

 Creating a Freeform Curve
  Palette: Curves > New Curve > New CV curve > New Sketch curve  

In Alias Design, a curve can also be created without specifying the CVs or edit points. 
You can create a freeform curve by dragging the mouse. However, CVs and edit points 
will be created automatically. To create a freeform curve, choose the New Sketch curve 

tool from the New Curve fl yout of the New CV curve tool in the Curves tab in the Palette; 
you will be prompted to sketch a curve. Press and hold the left mouse button and then drag 
the cursor in the active window; a freeform curve will be created.
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To set the parameters of the New Sketch curve  

Figure 2-44  The New Sketch Curve 
Options dialog box

tool, double-click on the New Sketch curve tool; 
the New Sketch Curve Options dialog box will be 
displayed, as shown in Figure 2-44.                                                                              

The Curve Degree option in this dialog box is the 
same as discussed earlier in the New CV Curve  
Options dialog box. The rest of the options in this 
dialog box are discussed next.

 Tolerance
This edit box is used to specify the closeness of the 
curve created with the path defi ned by dragging 
the cursor. By default, 3 is displayed in this edit 
box. You can change this value by entering a new 
value in this edit box. Alternatively, you can change 
the tolerance by using the slider bar given on the 
right of this edit box. 

 Maximum Spans
This edit box is used to specify the number of spans for the sketched curve. The number of 
spans works in coordination with the degrees of the curve to decide the number of points that 
will be used to generate the curve.

Figure 2-45 shows the path created by dragging the cursor and Figure 2-46 shows the curve 
created on this path.

Figure 2-46  Curve created on the pathFigure 2-45  Path created by dragging the 
cursor

 CREATING PRIMITIVES
The primitives are the building blocks that consist of a single surface or a group of surfaces. 
The primitive tools can be invoked from the Surfaces tab in the Palette or from the Surface 
Tools tab of the Shelves window. The primitives form the fi rst tool of the Surfaces tab. 
There are six primitives in Alias. These are sphere, torus, cylinder, cone, cube, and plane, as 
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shown in Figure 2-47. Besides these, circle is also considered as a primitive. The procedure 
of creating a circle primitive has already been discussed and the procedure of creating rest of 
the primitives are discussed next.

Figure 2-47 The Primitives fl yout of the Surfaces tab

Creating a Sphere
  Palette: Surfaces > Primitives > Sphere  

To create a sphere, choose the Sphere tool from the Primitives fl yout of the Surfaces 
tab in the Palette; you will be prompted to specify the position of the sphere. Click in 
the active window; a sphere will be created, as shown in Figure 2-48. To set the 

parameters of the Sphere tool, double-click on the Sphere tool; the Sphere Options dialog 
box will be displayed, as shown in Figure 2-49. The options in the Sphere Options dialog box 
are discussed next.

 Sphere Type
The Sphere Type area enables you to select the type of sphere. The radio buttons in this area 
are Surface, Shell Tennis ball, and Shell No-Pole. The Surface radio button is selected by 
default. When you select the Shell Tennis ball radio button, the sphere with the tennis ball 
profi le will be created, as shown in Figure 2-50. Select the Shell No-Pole radio button to create 
a sphere without poles, as shown in Figure 2-51. 

Figure 2-48  Sphere placed in the Perspective 
window

Figure 2-49  The Sphere Options dialog 
box
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Figure 2-51  Shell no-pole sphere placed in the 
Perspective window

Figure 2-50  Shell tennis ball sphere placed 
in the Perspective window

 Object Degree
The Object Degree area is used to select the degrees of the sphere. By default, the 3 radio 
button is selected. As a result, a sphere with smooth profi le will be created. If you select the 1 
radio button, a sphere with a rough profi le will be created.

Sweep
You can enter the value of sweep angle of the sphere in the Sweep edit box.

Sections           

Figure 2-52  Sphere with a sweep angle of 
150 degrees and 10 sections

The Sections edit box allows you to specify 
the number of sections in the sphere. You 
can also change the number of sections by  
using the slider bar given on right of the 
Sections edit box. Figure 2-52 shows the 
sphere with a sweep angle of 150 degrees 
and 10 sections.

Note
The Object Degree, Sweep, and      
Sections areas will be available only 
when you select the Surface radio 
button in the Sphere Type area.

 Creating a Torus
  Palette: Surfaces > Primitives > Torus  

To create a torus, choose the Torus tool from the Primitives fl yout of the Surfaces 
tab in the Pallete; you will be prompted to specify the position of the torus. Click in 
the active window; a torus will be created, as shown in Figure 2-53.
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To set the parameters of the Torus tool, double-click on the Torus tool; the New Torus Options 
dialog box will be displayed, as shown in Figure 2-54. The options in the New Torus Options 
dialog box are discussed next.

Figure 2-53  Torus placed in the Perspective 
window

Figure 2-54  The New Torus Options dialog 
box 

Sweep
You can enter the sweep angle for the torus in the Sweep edit box.

Size
This area enables you to specify the size of the torus. The radio buttons available in this area 
are discussed next.

Absolute
This radio button is selected by default. With this radio button selected, two edit boxes 
will be available that are discussed next.

Major radius
This edit box is used to enter the value of the major radius of the torus. The major 
radius is the distance between the center and the neutral axis of the torus. You can 
change the major radius by using the slider bar given on the right of the Major radius 
edit box.

 Minor radius
This edit box is used to enter the value of the minor radius of the torus. The minor 
radius is the radius of the cross-section of the torus. You can change the minor radius 
by using the slider bar given on the right of the Minor radius edit box.
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 Relative                           
If you select this radio button, the Ring thickness     

Figure 2-55  The New Torus Options dialog 
box with the Relative radio button selected

 
edit box will be displayed in the dialog box, as 
shown in Figure 2-55.

 Ring thickness
This edit box is used to enter the ring 
thickness of the torus. The ring thickness is 
the ratio of the diameter of the cross-section 
to the diameter of the torus. You can 
change the value of the ring thickness by 
using the slider bar given on the right 
of the Ring thickness edit box. The ring 
thickness value varies from 0.00001 to 
0.5. If the value is  0.5, the torus will be 
displayed without a hole at the center. 

Note
When you work on a tool, the options in the Control Panel change depending upon the tool 
being used.

 Creating a Cylinder
  Palette: Surfaces > Sphere > Cylinder  

To create a cylinder, choose the Cylinder tool from the Primitives fl yout of the Surfaces 
tab in the Pallete; you will be prompted to specify the cylinder position. Click in the 
active window; a cylinder will be created, as shown in Figure 2-56.

To set the parameters of the Cylinder tool, double-click on the Cylinder tool; the Cylinder 
Options dialog box will be displayed, as shown in Figure 2-57.

Figure 2-56  Cylinder created in the Perspective 
window

Figure 2-57  The Cylinder Options 
dialog box

The options in the Cylinder Options dialog box are discussed next.
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 Object Degree
This area is used to specify the degrees of the cylinder.

 

Caps
The Caps drop-down list is used to specify the number of caps or faces that will close a cylinder. 
Choose the 2 option from this drop-down list to create a cylinder with both ends closed, refer 
to Figure 2-56. Choose the 1 option from this drop-down to create a cylinder with one end 
closed, as shown in Figure 2-58. Choose the 0 option from this drop-down list to create a 
cylinder with both ends opened, as shown in Figure 2-59.

Figure 2-59  Cylinder with no caps at the endsFigure 2-58  Cylinder with a cap at the base

The other options in the dialog box are the same as discussed in the Sphere Options dialog box.

 Creating a Cone
  Palette: Surfaces > Primitives > Cone  

To create a cone, choose the Cone tool from the Primitives fl yout of the Surfaces tab 
in the Pallete; you will be prompted to specify the position of the cone. Click in the 
active window; a cone will be created, as shown in Figure 2-60.

To set the parameters of the Cone tool, double-click on the Cone tool; the Cone Options 
dialog box will be displayed, as shown in Figure 2-61.

The options in this dialog box are the same as those discussed in the Cylinder Options dialog 
box. By default, the 1 option is chosen in the Caps drop-down. Consequently, the cone with 
the closed base will be placed in the active window, as shown in Figure 2-60. If you choose 
the 0 option from this drop-down list, the cone with the opened base will be placed in the 
active window.
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Figure 2-60  Cone with the closed base created in 
the Perspective window

Figure 2-61  The Cone Options dialog 
box

Creating a Cube
  Palette: Surfaces > Primitives > Cube  

To create a cube, choose the Cube tool from the Primitives fl yout of the Surfaces tab 
in the Pallete; you will be prompted to enter the new position of the cone. Click at 
the required location to specify the point or enter coordinates in the promptline; a 

cube will be created in the window, as shown in Figure 2-62.

To set the parameters of the Cube tool, double-click on the Cube tool; the Cube Options 
dialog box will be displayed, as shown in Figure 2-63. The options in this dialog box are the 
same as those discussed earlier in the Cylinder Options dialog box.

Figure 2-62  Cube created in the Perspective 
window

Figure 2-63  The Cube Options dialog box
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Creating a Plane
  Palette: Surfaces > Primitives > Plane  

The Plane tool is used to create a

Figure 2-64  Plane created in the Perspective 
window

 
square NURBS surface. When you 
invoke  th i s  too l  f rom the                   

Primitives fl yout of the Surfaces tab in the 
Palette, you will be prompted to enter the 
new position of plane. Click in the active 
window; a plane will be created in the 
window at the specifi ed location, as shown 
in Figure 2-64.       
  
To set the parameters of the Plane tool, 
double-click on the Plane tool; the Plane 
Options dialog box will be displayed. The 
options in the dialog box are the same as those discussed earlier in the Cylinder Options 
dialog box.

 PICK TOOLS
Picking and unpicking of objects play an important role in modeling and editing in Alias Design. 
The tools in the Pick tab are used to select an entity or exit an active tool. There are different 
tools to pick and unpick specifi c components from the active window. You can pick an object 
by clicking on it or by dragging a pick box around it after choosing the required pick tool 
from the Pick tab. The different pick tools are discussed next.

 Picking Objects
  Palette: Pick > Pick object  

You can select an entity drawn in the active window. To do so, choose the Pick object 
tool from the Pick tab in the Palette; you will be prompted to use the mouse or to 
enter the name of the item to pick. To pick an object, left-click on the particular     

entity; the picked object will be highlighted. Alternatively, drag the mouse to defi ne a pick 
box around the objects to be picked; the objects lying inside and crossing the pick box will be 
selected.

To set the parameters of the Pick object tool, double-click on the Pick object tool; the Pick 
Object Options dialog box will be displayed, as shown in Figure 2-65.

 The option in this dialog box is discussed next.
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Figure 2-65  The Pick Object Options dialog box

Pick according to layers
The use of the Pick according to layers check box is signifi cant in the case of grouped objects. 
The grouping of objects will be discussed in detail in Chapter 5. To view the usage of this 
check box, group some objects and then assign the individual groups to different layers. Set 
some layers to inactive state. With the Pick according to layers check box selected, you can 
select the active layer objects individually from the active window but you cannot pick the 
inactive layer objects. If you clear this check box, you can select the whole group. However, 
you cannot select the active layer objects individually. This check box behaves in the same 
way as the reference layers.

Note
You can also invoke some pick tools from the Marking menus that was discussed in the previous 
chapter.

Tip: To analyze the signifi cance of the Pick according to layers check box, select 
some objects and then choose Edit > Group from the menu bar. You need to group 
these objects under a single node and assign different objects to different layers. 
Next, press and hold the left mouse button on any layer from the layer bar; a fl yout 
will be displayed. From this fl yout, choose Set state > Inactive; the layer chosen 
will get inactivated. Similarly, set some more layers to the inactive state.

 Picking Components
  Palette: Pick > Pick component  

You can pick the components 

Figure 2-66  The component fi lter buttons

individually by using the Pick 
component  tool.  An object            

consists of many components. For                   
example, a cube has six faces. To pick a 
single entity, invoke the Pick component 
tool from the Palette and select the 
required entity from the model in the active 
window; the selected entity will be           
highlighted. On invoking the Pick 
component tool, the component filter 
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tools will be displayed on the left of the promptline history, as shown in Figure 2-66. By default, 
all fi lter tools are displayed in active mode, indicating that all these components can be picked.

If you do not want to pick a particular component, choose the corresponding fi lter tool. 
While picking a component from a set of multiple components, the Pick chooser menu is 
displayed. The Pick chooser menu lists all the components near the selection point. Choose 
the required component from it.

To set the parameters of the Pick component tool, double-click on the Pick component tool; 
the Pick Component Options dialog box will be displayed, as shown in Figure 2-67.
The options in this dialog box are discussed next.

All
The All area is used to select or clear all the components of an object. The radio buttons in 
this area are discussed next. 

On 
This radio button is selected by default and all component check boxes will be selected. 
As a result, all the components of an object can be picked.

Off
Select the Off radio button to deselect all the components of an object. After clearing all the 
check boxes, you can manually select the individual check boxes to pick the components.

Curves
This check box is selected by default and is used to pick curves from an object.

Surfaces
This check box is used to pick surfaces from an object.

Meshes
This check box is used to pick meshed components from an object.

Sections
This check box is used to pick sectioned components from an object.  

 Construction Objects
This check box is used to pick the construction objects such as points, vectors, construction 
planes, and so on from an object.  

Shells
This check box is used to pick shelled components from an object.

Lights
This check box is used to pick lights from an object.
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Figure 2-67  The Pick Component Options dialog 
box

Others
This check box is used to pick the components such as camera, textures, and so on from the 
object.

Note
You will learn more about the meshes, sections, construction objects, shells, and other components 
in the later chapters.

 Picking Templates
  Palette: Pick > Pick template  

The Pick template tool is used to pick a template from the active window. If you do 
not want some objects to be modifi ed while modifying other objects, convert them 
into templates. You can convert selected objects into templates by choosing 

ObjectDisplay > Template from the menu bar. The templates are displayed in gray color, 
and when picked, the color changes to pink. 

 Picking Edit Points
  Palette: Pick > Pick edit point  

A curve or a surface consists of number of edit points. The Pick edit point tool is used 
to pick the edit points of a curve, surface, and so on. Choose the Pick edit point tool 
from the Pick tab in the Palette and then select the required edit point; the picked 

edit point will be highlighted in yellow in the window. 

To set the parameters of the Pick edit point tool, double-click on the Pick edit point tool; the 
Pick Edit Point Options dialog box will be displayed, as shown in Figure 2-68. The option in 
this dialog box is discussed next.
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Use Lasso
A lasso is a freeform curve that is drawn by dragging the mouse. Select the Use Lasso check 
box and draw a freeform curve using the left mouse button around the CVs that you need to 
pick. Note that you cannot pick the edit point by clicking on it if the Use Lasso check box is 
selected. If you clear this check box, you can pick the component by clicking on it or dragging 
a box around it.

Figure 2-68  The Pick Edit Point Options dialog 
box 

  Picking CVs
  Palette: Pick > Pick CV  

The control vertices are displayed on the hull of the curves and the surfaces. The Pick 
CV tool is used to pick the control vertices of the curves, surfaces, and other components 
of a model.  To pick the CV, invoke the Pick CV tool and select the required CV from 

the active window; the picked CV will be highlighted in yellow in the window. To set the 
parameters of the Pick CV tool, double-click on the Pick CV tool; the Pick CV Options dialog 
box will be displayed. The Use Lasso option in this dialog box is the same as discussed in the 
Pick Edit Point Options dialog box.

 Picking Hulls
  Palette: Pick > Pick CV > Pick hull  

You can pick lines connecting all CVs of a curve, surface, and so on by using the Pick 
hull tool. Choose the Pick hull tool from the Pick tab in the Palette and click on the 
hull; the picked hull will be highlighted in light brown in the active window. To view 

the hulls of a surface, select them from the window and then select the CV/Hull check box 
from the Display area of the Control Panel.

 Picking Curves-on-surface
  Palette: Pick > Pick curve-on-surface 

The curve-on-surface is a curve that does not have any CV. You can create 
curves-on-surface by intersecting the two surfaces, by projecting a curve on a surface, 
or by using the New curve-on-surface tool from the Curves tab in the Palette. To 

pick these curves, choose the Pick curve-on-surface tool and select the curve-on-surface from 
the active window. This curve can be used to trim the surfaces. Figure 2-69 shows a 
curve-on-surface picked using the Pick curve-on-surface tool. 
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Note
To create curve on a surface using the New 

Figure 2-69  Curve-on-surface picked using 
the Pick curve-on-surface tool

curve-on-surface tool, first select the 
surface and then start creating the curve 
on it. 

 Picking all Objects
  Palette: Pick > Pick curve-on-surface  
  > Pick all obj/lights          

You can select all objects from the active 
window by using the Pick all obj/lights 
tool. To do so, choose the Pick all obj/

lights tool from the Pick tab in the Palette; all objects (curves, surfaces, lights, cameras, 
templates, meshes, shells, and so on) in the window will be selected automatically. The Pick 
all obj/lights tool will be available only in the Default workfl ow. To invoke this workfl ow, choose 
Preferences > Workfl ows > Default from the menu bar or press CTRL+1 keys. 

 Picking Objects by Shaders
  Palette: Pick > Pick curve-on-surface > Pick by Shader  

You can also select the objects by using shaders. This is signifi cant when you need to 
select/pick the objects that have been assigned the same shades. To assign different 
shades to the objects, fi rst invoke the Visualize workfl ow by choosing Preferences > 

Workfl ows > Visualize from the menu bar or press CTRL+4 keys. Choose one of the tabs 
(Metals, Glass, Fabric, and so on) from the Shader Library area of the Control Panel; different 
shaders will be displayed. Double-click on the desired shader from the tab such that the 
shader gets displayed in the Resident Shaders tab of the Control Panel. Next, select the 
object from the window and then choose the Assign Current Shader tool from the Control 
Panel; the shader will be assigned to the selected object. Similarly, assign other shaders to 
other objects in the window and then invoke the Modeling workfl ow by choosing Preferences > 
Workfl ows > Modeling from the menu bar or by pressing CTRL+3 keys. To pick the object 
using the Pick by shader tool, fi rst select the object with the desired shader and then choose 
the Pick by shader tool from the Pick tab in the Palette; all the objects having the same 
shader will be picked automatically. If you invoke this tool and then select the object with the 
required shader; all other objects with the same shader will be selected automatically. 

 Picking Locators
  Palette: Pick > Pick locator  

The locators act as the reference points for measuring the dimensions, deviations, 
annotation, and so on. These locators can be created by using different locator tools 
from the Locators tab in the Palette. These locators can be assigned to different layers, 

and can be picked from the active window by using the Pick locator tool. You can pick 
annotation, dimension, and deviation locators using this tool. These locators will be discussed 
in the later chapters. 
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To set the parameters of the Pick locator tool, double-click on the Pick locator tool; the Pick 
Locator Options dialog box will be displayed, as shown in Figure 2-70. The options in this 
dialog box are discussed next.

Figure 2-70  The Pick Locator Options dialog box

 Measurement 
This check box is selected by default and is used to pick the locators that measure distance, 
angle, radius, and diameter.

 Deviation
This check box is also selected by default and is used to pick the locators that determine the 
close point deviation, deviation between curves, deviation between surfaces, deviations between 
a curve and a surface, and deviation between a mesh and a surface.

Others
This check box is also selected by default and is used to pick the locators that determine the 
arc length and the curvature of a curve.

 Picking Visible Objects
  Palette: Pick > Pick Visible  

You can use the Pick Visible tool to pick the surface that is hardware or diagnostic 
shaded. When the object is not shaded, this tool does not work. Select the shaded 
surface and then invoke the Pick Visible tool; the surface will get highlighted.

 Unpicking Objects
  Palette: Pick > Pick nothing  

Sometimes you may want to unpick an object that you no longer need. In such cases, 
you can use the Pick nothing tool to unpick the picked object. Choose the Pick nothing 
tool from the Pick tab in the Palette; the picked objects will be unpicked and the tool 

that was used before invoking the Pick nothing tool will be activated. 

Note
You can also unpick a picked object by selecting it again. 
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 TRANSFORM TOOLS
The transform tools are used to dynamically control the shape and development of the fi nal 
model. The transform tools are available in the Transform tab of the Palette. The primary 
transform tools such as Move, Rotate, and Scale are also available in the Shelves window 
and the Marking Menus. You can use the transform tools freely in the orthographic window. 
In the Perspective window, you can use these tools normal to the X, Y, and Z-axes only. The 
various transform tools are discussed next.

 Moving an Object
  Palette: Transform > Move  

You can dynamically move or translate an object to the desired position by using the 
Move tool. You can pick the object before or after invoking this tool. On invoking this 
tool, you will be prompted to specify the new position in relative or absolute units in 

the promptline. Enter the new position in the promptline or drag the object to move it 
dynamically to a new position. While moving the object in the Perspective window, the left, 
middle, and right mouse buttons are used to move the object in the X, Y, and Z directions, 
respectively. The dynamic display boxes showing the current position of the object in the 
corresponding direction will be displayed in all windows. This position keeps changing as you 
drag the cursor in the corresponding direction. In orthographic windows, these dynamic 
display boxes will be displayed only when you drag the cursor with the middle and the right 
mouse buttons. In orthographic windows, the left mouse button is used to move the object in 
desired direction, while the middle and right mouse buttons are used to move the object in 
horizontal and vertical directions, respectively. Figure 2-71 shows a cylinder and a sphere in 
the Front window and Figure 2-72 shows the sphere moved vertically upward in the same 
window.

Figure 2-72  Sphere moved vertically upwardFigure 2-71  A cylinder and a sphere in the 
Front window

Note
While using a transform tool, keep the cursor away from the objects to prevent the selection of  
wrong entities.
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Tip: While moving an object, if you press the ALT key, the cursor will snap to the 
grids. 

To set the parameters of the Move tool, double-click on the Move tool; the Move Options dialog 
box will be displayed, as shown in Figure 2-73. The options in the Move Options dialog box 
are discussed next. 

Type
This area is used to specify the coordinate system for moving an object. The two radio buttons 
in this area are discussed next.

Global
This radio button is selected by default and is used to move an object in the global X, Y, 
and Z coordinate system. 

Local
Select this radio button to move an object in the local X, Y, and Z coordinate system. The 
local coordinate system of the object is located at its pivot point. If there are more than one 
object in the scene, you can move the selected object with respect to its local coordinate 
system. Figure 2-74 shows the circle moved with respect to its local coordinate system.

Figure 2-74  Circle moved in the local coordinate 
system

Figure 2-73  The Move Options dialog box

 Rotating Objects
  Palette: Transform > Rotate  

You can rotate an object dynamically around the pivot point by using the Rotate tool. 
You can pick the object before or after invoking this tool. On invoking this tool, you 
will be prompted to specify the rotation angle. Enter the rotation angle in the 

promptline or rotate the object dynamically in the window. Use the left, middle, and right 
mouse buttons to rotate the object around the X, Y, and Z axes in any window, respectively. 
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Figure 2-75 shows a cube before rotation and Figure 2-76 shows the same cube rotated about 
the X-axis.

Figure 2-76  Cube rotated about the X axisFigure 2-75  Cube before rotation

To set the parameters of the Rotate tool, double-click on the Rotate tool; the Rotate Options 
dialog box will be displayed, as shown in Figure 2-77.

The options in the Rotate Options dialog box are discussed next.

Type
This area is used to specify the type of coordinate system for rotating an object. The three 
radio buttons in this area are discussed next.

Figure 2-77  The Rotate Options dialog box

Global
This radio button is selected by default and is used to rotate the object by incrementing 
its Euler rotation angles. The Euler rotation angles are used to specify the orientation 
of the rigid bodies. In this type of rotation, the rotation is fi rst done to Z, then to Y, and 
fi nally to X. In this way, the rotation about the X-axis depend on the rotation about the 
Y and Z axes.

Local
Select this radio button to rotate the object about the local X, Y, and Z coordinate system. 
The local coordinate system of the object is located at its pivot point. If there are more 
than one object in the window, you can rotate the selected object with respect to its local 
coordinate system.
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 Universe
Select the Universe radio button to rotate the object about the world X, Y, and Z coordinate 
system.

 Scaling an Object
  Palette: Transform > Scale  

You can dynamically scale the object uniformly or non-uniformly along the axes by 
using the Scale tool. You can pick the object before or after invoking this tool. On 
invoking  this tool, you will be prompted to enter the scale. Enter the scale in the 

promptline or drag the mouse to scale the object dynamically in the window. To scale the 
object uniformly, drag the cursor with the left mouse button in the orthographic or the 
Perspective window. The use of different mouse buttons in different windows for scaling the 
objects is listed in the table given next.

Mouse button Window Direction of scaling

Left
Top, Left, Back 
and Perspective

Uniformly along the X, Y, and Z axes

Middle

Top and Left X-axis

Back Y-axis

Perspective Uniformly along the X, Y, and Z axes

Right

Left and Back Z-axis

Top Y-axis

Perspective Uniformly along the X, Y, and Z axes

Scaling Objects Non proportionally

  Palette: Transform > Non proportional scale  

You can scale the object non-proportionally along the three axes by using the Non 
proportional scale tool. You can pick the object before or after invoking this tool. On 
invoking this tool, you will be prompted to specify the scale factor along the X, Y, and 

Z directions. Enter the scale factors in the promptline or drag the mouse buttons to scale the 
object dynamically in the window. The use of different mouse buttons for scaling the objects 
non-proportionally is given in the following table.

Mouse button Window Direction of scaling

Left

Top X and Y axes

Back Y and Z axes

Left X and Z axes

Perspective X-axis
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Middle
Top and Left X-axis

Back and Perspective Y-axis

Right
Top Y-axis

Left, Back, and Perspective Z-axis

Figure 2-78 shows a cube before scaling and Figure 2-79 shows the same cube scaled 
non-proportionally along the X-axis.

Figure 2-78  Cube before scaling Figure 2-79  Cube scaled non-proportionally 
along the X-axis

Setting the Pivot Point
  Palette: Transform > Local > Set pivot  

The pivot point plays an important

Figure 2-80  Torus showing the pivot point

 
role in various transforming 
operations such as moving, 

rotating, scaling, and so on. When you 
change the position of a pivot point, the 
transform operations will start about the 
new position of the pivot point. The new 
position of the pivot point will act as the 
starting point for any transform operation.
The Set pivot  tool is used to change the 
position of the pivot point of the picked 
object. When you pick an object, the pivot 
point will be highlighted in green, as shown 
in Figure 2-80. When you choose the Set 
pivot button, you will be prompted to enter a new position of the pivot point. Once you enter 
the new position, the pivot point will shift to it. You can also specify a new position for the 
pivot point by dragging the cursor in the active window. For example, a cylinder with the pivot 
point placed at the center is shown in Figure 2-81. You can change the position of the pivot 
point from the center to the top cap of the cylinder using the Set pivot tool, as shown in 
Figure 2-82.
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The functions of different mouse buttons in changing the position of the pivot point is given 
in the following table:

Figure 2-82  Pivot point shifted to the top cap Figure 2-81  Pivot point at center of the 
cylinder

Mouse button Window Movement direction

Left
Top, Left, and Back Free to move in any direction

Perspective X-axis

Middle
Top and Left X-axis

Back and Perspective Y-axis

Right
Left, Back, and Perspective Z-axis

Top Y-axis

To set the parameters of the pivot point, double-click on the Set pivot tool; the Set Pivot 
Options dialog box will be displayed, as shown in Figure 2-83.

There are two types of pivots in an object, rotation and scaling. The rotation pivot is displayed 
as a circle with a dot at the center and the scaling pivot is displayed as an asterisk (*). If you pick 
an object, these pivots will be displayed together. You can separate these pivots by changing 
the parameters in the Set Pivot Options dialog box. Figure 2-84 shows a sphere with the 
rotation and scaling pivots separated from each other.

The options in the Set Pivot Options dialog box are discussed next.

Rotation
This check box is selected by default and is used to change the position of the rotation pivot. To 
change the position of the rotation pivot without affecting the scaling pivot, clear the Scaling 
check box. Next, choose the Go button; you will be prompted to specify the new position of 
the pivot point. Enter the new position in the promptline or drag the cursor to the required 
position; the rotation pivot will be shifted to the new position.
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Figure 2-84  Sphere showing the rotation and 
scaling pivots separated from each other

Figure 2-83  The Set Pivot Options dialog 
box

Scaling
This check box is also selected by default and is used to change the position of the scaling 
pivot. To change the position of the scaling pivot without affecting the rotation pivot, select 
the Scaling check box and clear the Rotation check box. Next, choose the Go button; you 
will be prompted to enter the new position of the pivot point. Enter the new position in the 
promptline or drag the cursor to the required position; the scaling pivot will be shifted to the 
new position. 

 Move Selection Handle
The Move Selection Handle check box is selected by default and allows you to move the 
selection handle and the pivot point simultaneously. This check box will be available only 
when you select the Rotation check box. If you clear the Move Selection Handle check box, 
you can move the pivot point and the selection handle separately. Moving the selection handle 
separately is signifi cant in case the objects need to be selected, but, at the same time rotated 
or scaled about the center of mass or the pivot point. 

 Duplicating an Object Along a Curve or a Surface
  Palette: Transform > Object Placement > Duplicate Place Toolbox  

In Alias Design, you can create duplicate copies of an object along a curve by using 
the Duplicate Place Toolbox tool. The curve can be a free curve, isoparametric curve, 
curve-on-surface, edge of surface, and patch

Figure 2-85  The Duplicate Place 
Toolbox

 
precision curve. To create duplicate copies, choose the 
Duplicate Place Toolbox tool from the Object 
Placement fl yout of the Transform tab in the Palette; 
the Duplicate Place Toolbox will be displayed; as 
shown in Figure 2-85. Also, you will be prompted to 
select the geometry and the Accept Targets tool in the 
inactive state will be displayed. Select the object to be 
duplicated from the active window; the Accept Targets 
button will be activated. Choose the Accept Targets 
button; you will be prompted to select the curves or locator points. Also, the Accept Duplicate 
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Place Destination button in the inactive state will be displayed in the active window. Select 
the curve from the active window; the Accept Duplicate Place Destination button will be 
activated. Choose this button; the preview of the duplicate object will be attached to the curve 
and the Translate, Rotate, and Elevate buttons will be displayed in the active window. 

If you choose the Translate tool, you can move the duplicate object along the curve. If you 
choose the Rotate button, you can rotate the duplicate object about the curve. If you choose 
the Elevate button, you can move the duplicate object above or below the curve. After                     
choosing the required button from the active window, choose the Commit button from the 
Duplicate Place Toolbox; the confi rm message box will be displayed. Choose the Yes button 
from this message box; the duplicate copy of the object will be created. Figure 2-86 shows the 
target geometry and the destination curve. Figure 2-87 shows the duplicate copy of the target 
geometry placed along the curve after translation. 

If you have selected a wrong curve or target object for duplicating an object, choose the Revert 
button from the Duplicate Place Toolbox to restore the initial conditions. Next, specify the 
correct curve or target to create the duplicate copy of the object. 

You can set different parameters of the Duplicate Place Toolbox tool by choosing the Accept 
Targets button that is displayed when you select an object for creating its duplicate copy. Next, 
double-click on the Duplicate place button in the Duplicate Place Toolbox; the Duplicate 
Place Options dialog box will be displayed, as shown in Figure 2-88. 

Figure 2-87  Duplicate copy of target geometry 
placed along the curve after translation 

Figure 2-86  Target geometry and destination curve

Figure 2-88  The Duplicate Place Options 
dialog box
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The options in this dialog box are discussed next.

 Duplicate Place Control  
The options in this area used to specify the number of duplicate objects, spacing between the 
duplicate objects, and so on. These options are discussed next.

Num duplicates per destination
This edit box is used to specify the number

Figure 2-89  Five duplicate copies placed on the 
curve

 
of duplicate copies to be created. 
Alternatively, you can specify the 
number of duplicate copies by using 
the slider bar given on right of the 
Num duplicates per destination edit 
box. Figure 2-89 shows fi ve duplicate 
copies placed along a surface.

 Specify spacing between            
duplicates
When you select this check box, the 
Spacing between duplicates edit box 
will be displayed in the Duplicate 
Place Options dialog box.
 
 Spacing between duplicates
This edit box is used to specify the spacing between the duplicate copies of an object if 
the number of duplicate objects is more than one.

 Max num duplicates placed successfully
This display box displays the maximum number of duplicate objects that are created 
successfully on the curve. In other words, this display box informs about the number of 
duplicate objects that fi t on the destination curve.

 Keep target orientation
This check box is cleared by default. As a result, the duplicate objects orient according 
to the profi le of the surface such that they match the destination surface or curve. If 
you select this check box, the duplicate objects retain the orientation with respect to the 
original or target object. As a result, the duplicate objects do not rotate to match with the 
destination surface or curve. 

 Duplicate place
This tool is chosen by default and prompts you to select the object or geometry to be 
duplicated.

Revert
The Revert tool is used to delete the duplicate copies of the target geometry and 
remove the construction history of the duplicate objects.
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 Commit
Choose this tool to create the duplicate copies of the target object and delete the 
construction history. Note that after choosing this tool, you cannot change the duplicate 
geometry by changing the options in the Duplicate Place Toolbox dialog box.

 Show Pick Mask
The Show Pick Mask tool is used to fi lter out different geometries for the target or 
destination. If you invoke the Duplicate Place Toolbox tool and then select the 
geometry; the targets such as surfaces, meshes, and curves will be selected by default. 

If you choose the Show Pick Mask tool before selecting the geometry, you can fi lter targets 
and pick the required targets only. On choosing this tool, the Duplicate Place Pick Mask 
dialog box will be displayed, as shown in Figure 2-90.

The title bar of this dialog box changes according to the geometry selected. If you choose the 
Show Pick Mask tool before selecting the target geometry, the Duplicate Place Pick Mask : 
Add Target Group Mode dialog box will be displayed, refer to Figure 2-90. If you choose the 
Show Pick Mask tool from the Duplicate Place Toolbox before selecting the destination curve 
or geometry, the Duplicate Place Pick Mask : Add Destination Group Mode dialog box will 
be displayed. The Show Pick Mask tool will be activated only when you invoke the Duplicate 
Place Toolbox tool. Select or clear the check boxes in the Duplicate Place Toolbox dialog 
box to pick or unpick the corresponding geometries of the target or the destination objects.

Figure 2-90  The Duplicate Place Pick Mask : Add Target Group 
Mode  dialog box

Setting the Pivot Point at the Center
  Palette: Transform > Local > Center pivot  

Sometimes, you may need to position the pivot point at center of an object. This can 
be done by using the Center pivot tool. To place the pivot point at the center, select 
the object from the active window. Next, hold the left mouse button on the Set pivot 

tool; a fl yout will be displayed. Choose the Center pivot tool from this fl yout; the pivot point 
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will be placed at the center of the object. 

Figure 2-91 The Centre Pivot Options dialog box

This tool does not effect the position of 
the selection handle.  

To set the parameters of the Center pivot 
tool, double-click on the Center pivot 
tool; the Center Pivot Options dialog box 
will be displayed, as shown in Figure 2-91.
The Rotation and the Scaling check boxes 
are selected by default and they allow you 
to place the rotation and scaling pivots at 
the center of the object simultaneously. If you clear the Rotation check box, only the scaling 
pivot will be placed at the center of the object. If you clear the Scaling check box, only the 
rotation pivot will be placed at the center of the object. You cannot clear both check boxes 
simultaneously.

Rotating the local axes of the object
  Palette: Transform > Local > Set local axes  

You can set (rotate) the local axes of an object. To rotate the local axes of an object, 
select an object and then choose the Set local axes tool from the Local fl yout of the 
Transform tab in the Palette; the local axes will be displayed on the selected object. 

Next, drag the cursor to any of the windows to rotate the local axis. The direction of rotation 
depends on the active window in which you are dragging the cursor. Figures 2-92 shows the 
local axes of a cube and Figure 2-93 shows the rotated local axes. 

Figure 2-93  Rotated local axes of a cubeFigure 2-92  Local axes of a cube

To set the parameters of the Set local axes tool, double-click on the Set local axes tool; the 
Set Local Axes Options dialog box will be displayed, as shown in Figure 2-94. The options 
in this dialog box are discussed next.

Method 
The options in this area are used to specify the ways in which you can set local axes. These 
options are discussed next.
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Interactive
This radio button is selected by default. As a result, you can drag the local axes of the 
object(s) to rotate the local axes relative to the world axes. 

Object
This radio button is used to match the local axes of an object with the local axes of another 
object. While using this radio button, you need to select the object to which you want the 
selected object’s local axes to be matched with.

Figure 2-94  The Set Local Axes Options dialog box

 Resetting the Transformation of Objects
  Palette: Transform > Zero transforms  

Sometimes, you may need to reset the transformation (translation, scaling, or rotation) 
of the objects such that the new position of the objects become their origin or zero 
points. After resetting the transformation, the objects lose or forget their transformation 

information. To reset the transformation of the object, choose the Zero transforms button 
from the Transform tab in the Palette; the transformations applied to the selected object will 
be reset. To view the effect of the Zero transforms tool, select the component and then invoke 
the Information Window dialog box before and after resetting the transformation. You will 
notice that the transformations such as translation, rotation, and scale will be reset to their 
original values after applying the zero transformation.

Note
If you apply zero transformation to lights, camera, and 3D textures, the objects will be rendered 
incorrectly.

 SHADING OBJECTS IN VIEW WINDOWS
After creating a model in Alias Design, you can shade it to give more realistic look. 
There are two methods to apply shades to the model. These methods are discussed next.

 Diagnostic Shading
You can give a realistic look to a model by using diagnostic shading. Shading an object depends 
a lot on tessellation. Tessellation is the subdivision of geometry into regular or irregular 
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non-overlapping polygons. Polygons form a pattern that

Figure 2-95  The Diagnostic 
Shading dialog box

 
enables you to render an object with more accuracy as well as 
shade it easily. More the number of subdivisions of geometry 
(tessellation), better will be shade of the object. Some natural 
examples of tessellation are honeycomb, scales of fi sh, snake, 
pineapple, and so on. To shade an object, choose ObjectDisplay 
> Diagnostic Shading from the menu bar; the Diagnostic 
Shading dialog box will be displayed, as shown in Figure 2-95. 
Next, select the object and then choose the required tool from 
the Diagnostic Shading dialog box to shade the object. You 
can also shade an object by using the options of the Shading 
area displayed in the Control Panel. The options in the 
Diagnostic Shading dialog box are discussed next.

 Tolerance
This edit box is used to control the accuracy of surface 
tessellation when you choose the Fast option from the 
Tessellator area.
 

 Tessellator
This area is used to specify the method of tessellation. By default, the Fast button is chosen 
in this area. As a result, the object will be tessellated more quickly but with less accuracy. To 
make an object tessellate accurately, press and hold the left mouse button on the Fast button; 
a fl yout will be displayed. Choose the Accurate button from the fl yout; the object will tessellate 
slowly but accurately.

 Shading Off
Choose this tool to turn off the shading. On choosing this tool, the object will be 
displayed in the wire frame mode.

 Multi Color
Choose this tool to shade the object with a specifi c color. You can specify the color by 
choosing this tool and then picking a color from the Color swatch box that is displayed 
at the bottom of Diagnostic Shading dialog box. You can also change the specularity 

(refl ectivity), transparency, light intensity, and so on.

 Random Color
Choose this tool to shade the objects with different colors randomly. You can control 
color saturation, specularity, transparency, and light intensity of shaded objects by 
choosing this tool and then selecting the options that are displayed at the bottom of 

the Diagnostic Shading dialog box. 

 Horizontal/Vertical
Choose this button to display the horizontal and vertical highlights while shading 
objects. Highlights allow you to fi nd the surface fl aws, mismatched tangency between 
the surfaces, and so on. You can display the highlights horizontally or vertically by 



Working with Basic Tools                                      2-51

E
va

lu
a

ti
on

 C
op

y.
 D

o 
no

t 
re

pr
od

uc
e.

 F
or

 i
nf

or
m

a
ti

on
 v

is
it

 w
w

w
.c

a
dc

im
.c

om

choosing this tool and then selecting the required options that are displayed at the bottom of 
the Diagnostic Shading dialog box. You can specify the rate at which the highlights, horizontal 
or vertical, will repeat themselves. You can also specify the transparency of the highlights.

 Surface Evaluation
Choose this tool to shade the object in terms of surface evaluation options such as 
deviation map, deviation ramp, draft angle, and contact analysis. The surface 
evaluation tools will be discussed in Chapter 13. 

 User-defi ned texture
Choose this tool to shade an object with your own defi ned map textures. You can 
specify the mapping texture by choosing this tool and then selecting the required 
options displayed at the bottom of the Diagnostic Shading dialog box. You can also 

specify the rate at which the texture repeats itself as well as the transparency of the texture.

Apart from the tools discussed above, the Diagnostic Shading dialog box has three more 
tools; Visual State 1, Visual State 2, Visual State 3, and File State. You can create shading 
with these tools and then save them to user-preferences. Later on, you can retrieve those visual 
states. You can specify the shading settings to be assigned to a visual state tool for an object in 
the view window. To do so, select the object and then choose a visual state tool. Next, click on 
the arrow given below the visual state tools; the different options corresponding to the tool 
chosen will be displayed. The Shade Setting and Environment Editor options allow you to 
change the hardware shading and environment settings of the objects, respectively. You can 
also save a setting to user preferences by choosing the Save To Prefs option. If you choose 
the File State tool, the Save To Prefs tool will not be available. You can retrieve the settings 
of the last active environment by choosing the File State tool. 

 Hardware Shading
Hardware shading is used to shade objects to make them appear more realistic. You can even 
render the models that are shaded by using hardware shading. Hardware shading also enables 
you to toggle between the wireframe mode and the render preview views of the model. To shade 
objects with hardware shading, choose WindowDisplay > Hardware Shade from the menu 
bar; the objects will be shaded with the default hardware shade. You can also set the options 
for hardware shading. To do so, click on the box on the right of the Hardware Shade option; 
the Hardware Shade dialog box will be displayed, as shown in Figure 2-96. The options in 
this dialog box are discussed next.

Use Embedded File Settings
Select this check box to shade the objects with the hardware shade settings that were saved 
with the earlier fi le.

 All Windows
This check box is selected by default and is used to shade the objects in all view windows.
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Figure 2-96  The Hardware Shade dialog 
box

All Geometry
This check box is also selected by default and is used to shade all geometry in the view windows. 
Clear this check box to shade the active (selected) objects only.

 Shading Method
The Shading method area is used to specify the shading method used for shading the objects. 
By default, the Per vertex tool is chosen in this area, which helps in fast approximation of the 
surface at the time of modeling. If you choose the Per pixel tool from the Shading method 
area, the objects will be shaded as they obtain with Raycaster rendering. Raycaster rendering 
will be discussed in Chapter 12. To shade the model or object with the Per pixel tool chosen, 
you need to meet the graphic card requirement. 

 Tessellator
This area is used to specify the method of tessellation. The options in this area are the same 
as those discussed in the Tessellator area of the Diagnostic Shading dialog box.

Quality
This area is used to control the accuracy of tessellation while shading the surfaces. You can 
specify the quality of tessellation as high, low, or medium by choosing the corresponding 
 button from the Quality area. You can also specify a user-defi ned tessellation for shading by 
choosing the USER DEFINED button from this area. In this case, you need to specify the 
tolerance manually.
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 Texture Resolution
If you are using textures in shading the objects, you can use the Texture Resolution area to 
speed up the calculations in hardware rendering. You can specify 128, 256, 512, 1024, and 
2048 as the texture resolution by choosing the corresponding button from this area. You can 
turn off the texture resolution while rendering the object by choosing the Off button from this 
area. If you specify the texture resolution as 512, the texture will be rendered approximately 
to 512 x 512 pixels square. Note that the size of texture map should not be greater than the 
rendered texture. 

 Light source
The Light source area can be used to specify the source of light that will be used in shading 
the objects. You can use all lights, default lights, selected lights, and so on in the view window 
by choosing the corresponding button from this area.

Self Shadows
Select this check box to add additional information about the spatial relationships between 
the objects when they cast shadow on themselves. These self shadows appear different with 
different buttons of the Light source area.

 Auto update
This check box is selected by default and is used to automatically update the modifi cations 
done in the view windows.

 Enable Environment Effects
This area can be used to specify the parameters related to the environment. The different 
options in this area are discussed next.

 Use Environment
This check box is selected by default and enables you to use the environment in the background. 
The environments will be available in the environments tab that will be displayed if you 
invoke the Visualize workfl ow. These environments help you apply refl ection of model in the 
environments.

 Show Background
Select this check box to display the background while shading the object.

 Ground Plane
Select this check box to display the ground plane, ground plane shadow, and ground plane 
refl ections in the view window. 

 Shader Glow
Select this check box to self-illuminate the objects. The shader glows illuminate the objects 
which they are assigned without affecting the environment or other surrounding objects. 
Shader glows cannot be viewed in refl ections or ground planes. 
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 Edit Environment
Choose this tool to invoke the Environment editor that can be used to edit the environment 
used to shade the objects.

 Optimize during Tumble
This area can be used to optimize certain parameters related to the object during hardware 
shading. The options in this area can be used to optimize self shadows, shader glows, and 
ground plane refl ections of the objects while doing camera operations such as track, tumble, and 
dolly. When you select a check box, the respective parameters of the object get approximated 
and are updated when you release the mouse. 

 Shade Off
Choose this tool to turn off the hardware shading of the objects.

 Shade On
Choose this tool to turn on the hardware shading of the objects.

Note
1. You will learn how to shade objects in the tutorials of the later chapters. In some tutorials, 
you will shade models by using the Diagnostic Shading option, and in others, you will use the 
Hardware shading option.

2. An alternative method of invoking the Hardware Shade dialog box is by choosing the Shade 
Setting option from the options available on choosing any of the visual states or the File State 
buttons.  

TUTORIALS

Tutorial 1

In this tutorial, you will create the 3D model of a globe, as shown in Figure 2-97. After 
creating the model, you will shade it for giving it a realistic look.       (Expected time: 30 min)

The following steps are required to complete this tutorial: 

a. Start Alias and then start a new wire fi le.
b. Change the grid settings of the window.
c. Create the base of the globe by using the Cylinder tool.
d. Scale the base of the globe by using the Non proportional scale tool.
e. Create the stand of the globe by using the Cylinder tool.
f. Scale the stand of the globe by using the Non proportional scale tool. 
g. Create the ring of the globe by using the Torus tool and change its parameters.
h. Create the globe by using the Sphere tool. 
i. Create the axial rod by using the Cylinder tool.
j. Rotate the axial rod by using the Rotate tool.
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k. Shade the model by using the Diagnostic Shading option.
l.  Save the model and exit.

Figure 2-97  3D model of a globe

Starting a New Wire File
1. Choose Start > All Programs > Autodesk > Alias Design 2012 > Alias Design 2012 

from the taskbar; the Autodesk Alias Design 2012 window informing about the start of 
the software is displayed. Alternatively, you can start Alias Design 2012 by double-clicking 
on the its icon on the desktop of your system.

 As Alias Design 2012 gets started, the Essential Skills Movies window is displayed. This 
window enables you to view the short movie clips related to the basic commands used 
in Alias Design. The commands include creating objects such as curves, surfaces and 
primitives, transforming objects, selecting objects, exploring the user interface, and so on. 

2. Select the Don’t show again check box from the Essential Skills Movies window and 
close the window. As a result, next time when you start a new session of Alias Design, this 
window does not open automatically. However, you can invoke this window manually by 
choosing Help > Essential Skills from the menu bar.    

 By default, four windows are displayed on the screen when you start Alias Design. You can 
change the display of these windows by choosing the Layouts menu from the menu bar 
and then selecting the required window. In this tutorial, you will use all these windows for 
modeling.

Changing Grid Settings
 Next, you need to change the units and grid settings of the windows. From this tutorial 

onwards, set units to millimeters and the grid spacing to 1 unit.

1. Choose Preferences > Construction Options from the menu bar; the Construction 
Options dialog box is displayed. 

2. Click on the down-arrow on the left of the Units option; the different types of units are 
displayed. Click on the Linear down-arrow; various options are displayed. 
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3. Set mm in the Main Units option, if not set already. Close the Construction Options 
dialog box. 

 
4. Choose Windows > Palette from the menu bar, if the Palette is not displayed by default 

. Choose the Construction tab from the Palette; various tools in the tab are displayed. 

5. Double-click on the Grid preset tool from the Construction tab in the Palette;  
the Preset Grid Options dialog box is displayed.    

6. Enter 100 and 3200 in the Grid Spacing and Perspective Grid Extent edit boxes, 
respectively. Next, choose the Go button; the grid spacing is set to 100 units.

Creating the Base of the Model
 You need to create the base of the model using the Cylinder tool. 

1. Choose Primitives > Cylinder from the Surfaces tab in the Palette; you are 
prompted to enter the position of the cylinder. 

2. Enter 0, 0, 25 in the promptline and press ENTER; the cylinder is created, as shown in 
Figure 2-98.

3. Exit the Cylinder tool by choosing the Pick object tool from the Pick tab in the  
Palette.

Scaling the Base
 The cylinder created may not be of the required shape and size. So, you need to scale it 

using the Transform tools.

1. Select the cylinder from the window and choose the Non proportional scale tool  
from the Transform tab in the Palette; you are prompted to enter the scale factors 
along the X, Y, and Z axes.

2. Enter 300, 300, 50 in the promptline and press ENTER; the base is scaled, as shown in 
Figure 2-99.

Figure 2-98  Cylinder created for the base of 
the model

Figure 2-99  Base of the model after scaling
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Creating the Stand of the Globe
 After creating and scaling the base, you need to create the stand of the globe using the 

Cylinder tool.

1. Choose the Cylinder tool from the Primitives  fl yout  of the Surfaces tab in the 
Palette; you are prompted to enter the position of the cylinder. 

2. Enter 0, 0, 75 in the promptline and press ENTER; the stand of the model is created, as 
shown in Figure 2-100.

Scaling the Stand
 The stand of the model can be scaled in a way similar to the scaling of the base, using the 

Transform tools.
1. Choose the Non proportional scale tool from the Transform tab in the Palette;  

you are prompted to enter the scale factors along the X, Y, and Z axes.

2. Enter 75, 75, 50 in the promptline; the stand is scaled, as shown in Figure 2-101.

Figure 2-101  Model after scaling the standFigure 2-100  Stand created for the model

Creating the Ring of the Globe
 Next, you need to create the ring of the globe using the Torus tool. Before invoking the 

Torus tool, you need to set the parameters of the torus. After changing the parameters 
of the ring, rotate it to get the desired position.

1. Choose Primitives > Torus from the Surfaces tab in the Palette and then double-click  
on the Torus tool; the New Torus Options dialog box is displayed. 

2. In the Size area of this dialog box, select the Absolute radio button.

3. Enter 210, 1.5, 0.15 in the Sweep, Major radius and Minor radius edit boxes, respectively, 
and then choose the Go button. 

4. Enter 0, 0, 250 in the promptline and press ENTER; the ring is created in the window, 
as shown in Figure 2-102. 
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5. Choose the Rotate tool from the Transform tab in the Palette; you are prompted  
to enter the rotation angle about the X, Y and Z axes.

6. Enter 90, 45, 0 in the promptline and press ENTER; the ring is rotated about the X and 
Y axes, as shown in Figure 2-103. 

Creating the Globe
 Next, you need to create the globe using the Sphere tool. 

1. Choose Torus > Sphere from the Surfaces tab in the Palette; you are prompted to  
enter the position of the sphere.

Figure 2-103  Model after rotating the ringFigure 2-102  Torus created for the ring of the globe

2. Enter 0, 0, 250 in the promptline and press ENTER; the globe is created in the window, 
as shown in Figure 2-104.

Scaling the Globe
 Next, you need to scale the globe using the Scale tool from the Transform tab. 
 
1. Choose the Scale tool from the Transform tab in the Palette; you are prompted  

to enter the scale factor.

2. Enter 225 in the promptline and press ENTER; the globe is scaled uniformly along the 
X, Y, and Z axes, as shown in Figure 2-105.
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Figure 2-105  Globe created after scaling the sphereFigure 2-104  Sphere created for the globe

Creating the Axial Rod
 After creating the globe, you need to create an axial rod around which the globe will be 

rotated. This rod needs to be created by using the Cylinder tool. Later, you need to rotate 
and scale this cylinder to get the required position and size of the rod.

1. Choose Primitives > Cylinder from the Surfaces tab in the Palette; you are 
prompted to enter the position of the cylinder.

2. Enter 0, 0, 250 in the promptline and press ENTER; the axial rod is created, as shown in 
Figure 2-106.

Scaling and Rotating the Axial Rod 
 Next, you need to scale and rotate the axial rod using the Scale and Rotate tools of the 

Transform tab.

1. Choose the Non proportional scale tool from the Transform tab in the Palette;  
you are prompted to enter the scale factors along the X, Y, and Z axes.

2. Enter 15, 15, 350 in the promptline and press ENTER; the axial rod is scaled, as shown 
in Figure 2-107.

3. Next, choose the Rotate tool from the Transform tab in the Palette; you are 
prompted to enter the rotation angle about the X, Y and Z axes.

4. Enter 0, -30, 0 in the promptline and press ENTER; the ring is rotated about the Y-axis, 
as shown in Figure 2-108.

5. Choose the Pick nothing tool from the Pick tab in the Palette to exit the Rotate tool.



2-60            Learning Autodesk Alias Design
E
va

lu
a

ti
on

 C
op

y.
 D

o 
no

t 
re

pr
od

uc
e.

 F
or

 i
nf

or
m

a
ti

on
 v

is
it

 w
w

w
.c

a
dc

im
.c

om

Figure 2-107  Model after scaling the axial rodFigure 2-106  Model after creating the cylinder 
for the axial rod

Applying the Diagnostic Shading to the Model
 The model you have created is in the wireframe mode. For a better view, you need to shade 

the model. 

1. Choose ObjectDisplay > Diagnostic Shading from the menu bar; the Diagnostic Shading 
dialog box is displayed.

 
2. Choose the Multi Color tool in the Shading area; the model is shaded. You can  

choose the other tools in this area to get the required shades. 

3. Next, close the Diagnostic Shading dialog box.

4. Select the entire model and then clear the Isoparm U and V check boxes in the Display 
area of the Control Panel; the isoparametric curves in the model are hidden. The model 
after hiding the isoparametric curves is displayed, as shown in Figure 2-109.

Note
You can improve the quality of the display of the model by selecting the Accurate option from 
the Tessellator area of the Control Panel.

Saving the File
 To save the above model, create a new project directory c02_tutorials. The new directory helps 

in storing all fi les effi ciently.  

1. Choose File > Save from the menu bar; the Save Wire dialog box is displayed. You can 
also invoke this dialog box by pressing the ALT+S keys.
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Figure 2-109  Model after hiding the isoparametric 
curves

Figure 2-108  Model after rotating the axial rod

2. Click on the down arrow next to the Project fi eld and then select the New Project option 
from the drop-down list; the new project is displayed in the Save in drop-down list.

3. Browse to the aliasdesign_2012 folder in the Save in drop-down list; all fi les and folders 
are displayed in the list box. 

4. Choose the Create New Folder tool from the Save Wire dialog box and name the new 
folder as c02_tutorials.

5. Double-click on the c02_tutorials folder to display it in the Save in drop-down list.

6. Next, choose the Set Current option from the Project fi eld; the Confi rm message box is 
displayed.

7. Choose OK from the Confi rm message box and then enter c02_tut01 in the Object name 
edit box.

8. Choose the Save button; Alias Design saves the fi le as c02_tut01.wire. The location of this 
fi le is given below:

 \aliasdesign_2012\c02_tutorials\c02_tut01.wire

9. Choose File > Exit from the menu bar; the confi rm message box is displayed.

10. Choose the Don’t Save button from the message box to exit the application.
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Tutorial 2

In this tutorial, you will create a pencil, as shown in Figure 2-110. After creating the model, 
you will shade it to give it a realistic look.            (Expected time: 45 min)

The following steps are required to complete this tutorial:

a. Start Alias Design and then start a new wire fi le.
b. Create the base feature of the pencil by using the Cylinder tool.
c. Change the pivot point of the base feature by using the Set pivot tool.
d. Scale the base feature by using the Non proportional scale tool.
e. Create the tip of the pencil by using the Cone tool.
f. Rotate and scale the tip of the pencil by using the Transform tab.
g. Create the eraser holder of the pencil by using the Cylinder tool. 
h. Scale the eraser holder by using the Non proportional scale tool.
i. Create the base of the eraser by using the Cylinder tool. 
j. Change the pivot point of the eraser holder by using the Set pivot tool and then scale it 

by using the Non proportional scale tool.
k. Create the top part of the eraser by using the Sphere tool.
l. Rotate the top part of the eraser by using the Rotate tool.
m. Shade the pencil by using the Diagnostic Shading option.
n. Save the fi le and exit.

Figure 2-110  3D model of the pencil

Starting a New Wire File
1. Choose Start > All Programs > Autodesk > Alias Design 2012 > Alias Design 2012 

from taskbar; the Autodesk Alias Design 2012 window is displayed. 

 As you have selected the Don’t show again check box from the Essential Skills Movies 
window in the previous tutorial, the Essential Skills Movies window in not displayed. You 
can change the display of the windows by choosing the Layouts option from the menu bar 
and then selecting the required window. In this tutorial, you will use these four windows 
for modeling.
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Creating the Base Feature
 As you have specifi ed the grid and unit settings in Tutorial 1 of this chapter, you need 

not specify them again. With the settings in the previous tutorial, you need to create the 
base feature using the Cylinder tool. 

1. Choose Primitives > Cylinder from the Surfaces tab in the Palette; you are 
prompted to enter the position of the cylinder. 

2. Enter 0, 0, 200 in the promptline and press ENTER; the base feature is  created, as shown 
in Figure 2-111.

Changing the Pivot Point
 The transform operations such as move, rotate, and scale are performed on objects with 

respect to their pivot points. In other words, these operations are done toward or away 
from the pivot points along all directions. In order to scale the base feature in the upward 
direction, you need to change the location of the pivot point from the center to the bottom 
of the cylinder.

1. Choose the Set pivot tool from the Transform tab in the Palette; you are prompted 
to enter the new pivot position.

2. Enter 0, 0, 150 in the promptline and press ENTER; the pivot point is shifted to the 
bottom of the base feature.   

 

Scaling the Base Feature
 Next, you need to scale the base feature using the Non proportional scale tool.

1. Choose the Non proportional scale tool from the Transform tab in the Palette;  
you are prompted to enter the scale factors along the X, Y, and Z axes.

2. Enter 100, 100, 800 in the promptline and press ENTER; the base feature is scaled 
non-uniformly along the X, Y, and Z axes, as shown in Figure 2-112.

Creating the Tip of the Pencil
 After creating the base feature, you need to create the tip of the pencil by using the Cone 

tool.

1. Choose Primitives > Cone from the Surfaces tab in the Palette; you are prompted to 
enter the position of the cone in the promptline. 
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Figure 2-112  Base feature scaledFigure 2-111  Base feature

2. Enter 0, 0, 150 in the promptline and press

Figure 2-113  Model after creating the tip of 
the pencil

 
ENTER; the tip of the pencil is created, as 
shown in Figure 2-113.

Scaling and Rotating the Tip of 
the Pencil
 Next, you need to scale and rotate the tip 

of the pencil by using the Scale and Rotate 
tools  in the Transform tab.

1. Choose the Non proportional scale             
tool from the Transform tab in the Palette; 
you are prompted to enter the scale factors 
along the X, Y, and Z axes.

2. Enter 100, 100, 150 in the promptline and press ENTER; the tip of the pencil is scaled, 
as shown in Figure 2-114. 

3. Choose the Rotate tool from the Transform tab in the Palette; you are prompted  
to enter the rotation angle about the X, Y and Z axes.

4. Enter 180, 0, 0 in the promptline and press ENTER; the tip is rotated about the X-axis, 
as shown in Figure 2-115.

Creating the Eraser Holder
 Next, you need to create the eraser holder by using the Cylinder tool.

1. Choose Primitives > Cylinder from the Surfaces tab in the Palette. Next,    
double-click on the Cylinder tool; the Cylinder Options dialog box is displayed.

2. Choose the 0 tool from the Caps area.
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Figure 2-115  Model after rotating the tipFigure 2-114  Model after scaling the tip

3. Next, choose the Go button to exit the Cylinder Options dialog box; you are prompted 
to enter the position of the cylinder.

4. Enter 0, 0, 950 in the promptline and press ENTER; the eraser holder is created in the 
window, as shown in Figure 2-116.

 

Scaling the Eraser Holder
 Next, you need to scale the eraser holder non-proportionally by using the Transform tab.

1. Choose the Non proportional scale tool from the Transform tab in the Palette;  
you are prompted to enter the scale factors along the X, Y, and Z axes.

2. Enter 110, 110, 50 in the promptline and press ENTER; the eraser holder is scaled, as 
shown in Figure 2-117.

Figure 2-117  Model after scaling the eraser holderFigure 2-116  Model after creating the eraser holder 

Creating the Base of the Eraser
 After creating the eraser holder, you need to create the base of the eraser using the 

Cylinder tool.
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1. Choose the Cylinder tool from the Primitives fl yout of the Surfaces tab in the 
Palette; you are prompted to enter the position of the cylinder.

 
2. Enter 0, 0, 1000 in the promptline and press ENTER; the base of the eraser is created, 

as shown in Figure 2-118.

Changing the Pivot Point and Scaling the Bottom Part of the Eraser
 You need to change the position of the pivot point from the center to the bottom of the 

eraser and then scale it with respect to the new position of the pivot point.

1. Choose the Set pivot tool from the Local fl yout of the Transform tab in the Palette;  
you are prompted to enter the new pivot position.

2. Enter 0, 0, 950 in the promptline and press ENTER; the pivot point is shifted to the  bottom 
of the eraser, that is, the top of the base feature.

3. Choose the Non proportional scale tool from the Transform tab in the Palette;  
you are prompted to enter the scale factors along the X, Y, and Z axes.

4. Enter 100, 100, 50 in the promptline and press ENTER; the base of the eraser is scaled, 
as shown in Figure 2-119.

Figure 2-119  Model after scaling the base of 
the eraser

Figure 2-118  Model after creating the base 
of the eraser

Creating the Top Part of the Eraser 
 After creating and scaling the bottom part of the eraser, you need to create the hemispherical 

top part of the eraser by using the Sphere tool.

1. Choose Primitives > Sphere from the Surfaces tab in the Palette and then 
double-click on it; the Sphere Options dialog box is displayed. 

2. Enter the value 180 in the Sweep edit box and press ENTER.

3. Choose the Go button to exit the Sphere Options dialog box.



Working with Basic Tools                                      2-67

E
va

lu
a

ti
on

 C
op

y.
 D

o 
no

t 
re

pr
od

uc
e.

 F
or

 i
nf

or
m

a
ti

on
 v

is
it

 w
w

w
.c

a
dc

im
.c

om

4. Enter 0, 0, 1000 in the promptline and press ENTER; the hemispherical top part is created 
in the window, as shown in Figure 2-120.

Rotating the Top Part of the Eraser
 Next, you need to rotate the hemispherical top part of the eraser about the X-axis using 

the Transform tab.
 
1. Choose the Rotate tool from the Transform tab in the Palette; you are prompted  

to enter the rotation angle about the X, Y, and Z-axes.

2. Enter 90, 0, 0 in the promptline and press ENTER; the hemispherical top part is rotated 
about the X-axis, as shown in Figure 2-121.

Applying the Diagnostic Shading to the Model
 The model that you have created is in the wireframe mode. For a better view, you need 

to shade the model. 

1. Choose ObjectDisplay > Diagnostic Shading from the menu bar; the Diagnostic Shading 
dialog box is displayed. 

Figure 2-121  Model after rotating the top 
part of the eraser about X-axis 

Figure 2-120  Model after creating the   
hemispherical top part of the eraser

2. Choose the Multi Color tool from the Shading 

Figure 2-122  Model after hiding the 
isoparametric curves

area; the model is shaded. You can also 
choose the other tools from this area to get 
different shades.

3. Select the entire model and then clear 
the Isoparm U and V check boxes in 
the Display area of the Control Panel; 
the isoparametric curves in the model 
are hidden. The model after hiding the 
isoparametric curves is displayed, as shown 
in Figure 2-122.
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Saving the File
 You need to save the model created in the c02_tutorials folder with the name c02_tut02. 

As you have created the c02_tutorials folder in Tutorial 1 and set it as the current project, 
you need not to create a new folder. 

1. Choose File > Save As from the menu bar; the Save Wire dialog box is displayed. You 
can also invoke this dialog box by pressing the ALT+S keys.

2. Click on the down arrow given on the right of the Go fi eld to display the list and select 
Current Project from this list.

3. Enter c02_tut02 in the Object name edit box and then choose the Save button; Alias 
Design saves the fi le as c02_tut02.wire. 

 The location of this fi le is given below:

 \aliasdesign_2012\c02_tutorials\c02_tut02.wire

4. Choose File > Exit from the menu bar; the confi rm message box is displayed.

5. Choose the Don’t Save button from the message box to exit the application.

Self-Evaluation Test
Answer the following questions and then compare them to those given at the end of this 
chapter: 

1. You can invoke a tool from the shortcut menu that is displayed when you right-click on a 
particular tab in the Palette. (T/F)

2. The curve-on-surface displays CVs when it is created. (T/F)

3. You can change the parameters of a primitive by double-clicking on its tool. (T/F)

4. In the Cylinder Options dialog box, 1 is selected as the default degree. (T/F)

5. In Alias, a circle is considered as a primitive. (T/F) 

6. A line joining the CVs of a curve is known as __________.

7. There are __________ options in the Ellipse defi nition area that are used to create an 
ellipse.

8. The __________ area is used to specify parameters for edit points while working on the 
New CV curve tool.



Working with Basic Tools                                      2-69

E
va

lu
a

ti
on

 C
op

y.
 D

o 
no

t 
re

pr
od

uc
e.

 F
or

 i
nf

or
m

a
ti

on
 v

is
it

 w
w

w
.c

a
dc

im
.c

om

9. While working with curves, you can view the changing degrees in the __________.

10. You can enter coordinates in the __________ to specify the position of the primitives such 
as sphere, cylinder, cone, and so on.

Review Questions
Answer the following questions:

1. The __________ tab is used to invoke the Move tool from the Palette or the Shelves window.

2. Which of the following pick tools is used to pick a single entity from a group of entities?

  (a) Pick object    (b) Pick component
  (c) Pick template   (d) Pick CV

3. How many primitives are available in the Transform tab of the Palette?
 
  (a) 2     (b) 4
  (c) 6     (d) 7

4. Which of the following options is not available in the Caps area of the Cylinder Options 
dialog box?

  (a) 0     (b) 1
  (c) 2     (d) 3

5. Which of the following is not a CV symbol?

  (a) Box     (b) u
  (c) x     (d) *

6. Span is the length of a curve segment between two edit points. (T/F)
 
7. Axis length ratio is the ratio of the minor axis to the length of the major axis of an ellipse. 

(T/F)

8. If you create a curve with uniform knot spacing, the fi rst and last edit point parameter 
values of the curve will be equal to 0 and chord length, respectively. (T/F)

9. While working on curves using the __________ option, you can increase the degree of the 
curve progressively up to the fi nal degree.

10. CVs are preferred over edit points for editing a curve. (T/F)
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Exercises

Exercise 1 
Create a table and a tennis ball, as shown in Figure 2-123. After creating the model, you need 
to shade it to give it a realistic look.                        (Expected time: 45 min)

Hint
Use the Cube tool for creating the legs of the table. After creating the legs, scale them 
non-uniformly and rotate them 45-degree about two axes. 

Exercise 2 

Create a pen stand, as shown in Figure 2-124. After creating the model, you need to shade it 
to give it a realistic look.               (Expected time: 30 min)

Figure 2-123   Model for Exercise 1 Figure 2-124  Model for Exercise 2

Answers to Self-Evaluation Test
1. T, 2. F, 3. T, 4. F, 5. T, 6. hull, 7. two, 8. Knot Spacing, 9. Control Panel, 10. promptline


